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CHAPTER 1

Introduction

Congratulations on your purchase of a NexPath Telephony Server! This revolutionary new solution to smallcompany phone systems allows you to have all the features and functions of the phone systems used by large
companies, but at a fraction of what large systems cost.
In fact, in many ways the NexPath Telephony Server goes beyond the functionality of most large-company
telephone systems. The NexPath Telephony Server was the first web-enabled telephone system when it was
introduced in late 1996. It has unique features not commonly found on larger systems, such as allowing you
to perform functions like picking up a ringing phone from any other phone, checking and retrieving your
voice mail from any desktop computer in the building or on the Internet, ring groups within call distribution
groups, and many other features that are unique to NexPath.
Note

This manual, along with all other system manuals, are available on the NexPath Telephony Server in
Adobe Acrobat format, if you have a web browser and your PC is connected to the LAN. The URL for
the list of manuals is http://<system name>/manuals/1. Other URLs that are useful are available on the
NexPath Telephony Server at the URL http://<system name>/help/.

1. Replace <system name> with the name assigned your specific NexPath Telephony Server by your system administrator,
or the IP address of the NexPath Telephony Server. If you use the IP address, you must put in the trailing “/”.
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The NexPath Telephony Server combines the following subsystems into a single, tightly integrated, easy-toinstall, easy-to-maintain package:

• A complete switching system (PBX-like functions)
• Up to 136-line (outside+inside lines) capability.
• Functions such as call routing and switching can be performed using standard touch-tone codes
from conventional telephones. No expensive, proprietary phones are necessary.
• High bandwidth (64 kilobits per second), all digital signal paths pass fax and modem signals transparently.
• Automatic fax detection
• An auto-attendant system
• Allows automated answering and routing of calls.
• Fully configurable, including custom messages and flexible numbering plans.
• Multiple auto-attendants with a different auto-attendant on each line if desired.
• A voice message recording and retrieval (i.e., voice mail) system
• Over 50 hours of voice mail and custom messages can be stored per system.
• Password protection provided for all voice mail access.
• Personal greetings can be recorded for each extension.
• 64 kilobits-per-second digitization, storage, and playback gives your messages unsurpassed clarity.
• 30 port simultaneous voice mail access capability.
• Support of the VMWI (FSK) voice mail waiting light.
• An Automatic Call Distribution (ACD) system
• Allows calls to be directed to a group, such as sales, rather than just to an individual.
• Multiple overlapping distribution groups with priority settings.
• Custom reassurance messages and hold music while the caller is waiting in the hold queue.
Other features include:

• Integrated TCP/IP LAN for network control and administration
• System administration is performed using standard Web browser (Netscape or Internet Explorer)
software running on any desktop computer.
• Control of any extension can be performed either from a telephone, from the Windows programs
NexDial or NexDirector, or from a Netscape Web browser software running on any desktop com-
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puter.
• Complete backup via LAN command, and retrieval of the backup file via ftp.
• A completely open network API (NexPath Simple Computer Telephony Protocol, N-SCTP) for
custom application development and 1st and 3rd party call control.
Voice prompts and error messages available for all telephone operations
A public address output for announcements and speaker ringing
A music-on-hold input
Multiple auto-attendants and ACD groups can be set up
Call waiting and call forwarding
A complete system activity log
Ring groups, including ring groups in ACD groups
Distinctive ringing
Reminder rings
Multiple hold stack
Park orbits
Barge-in to voice mail in progress
Listen-in to voice mail in progress
Caller-ID pass-through and decoding
Power-failure bypass relays on all CO lines
Multiple extension number assignment capability per line
Numeric page upon receipt of voice mail
System speed dial numbers
Email notification upon receipt of voice mail.

Legal Notices
WARNING: The NexPath Telephony Server can be programmed to allow users, if the feature is enabled
by the system administrator and a valid password is entered, to listen in to conversations without the participants knowledge. Listening in to a conversation without the consent of one or both parties may be a viola-
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tion of local, state, and federal privacy laws. It is the responsibility of the user of the NexPath Telephony
Server, when using features of the system, to assure that he or she is in compliance with all applicable laws.
WARNING: The NexPath Telephony Server includes a LAN based protocol, NexPath Simple Computer
Telephony Protocol (N-SCTP), that allows the system to be programmed to function as an Automatic Dial
and Announce Device (ADAD). ADADs or similar devices that are used for commercial solicitation, or
used without the consent of the called party, are prohibited by many local, state, and federal laws. It is the
responsibility of the user of the NexPath Telephony Server, when using features of the system, to assure that
he or she is in compliance with all applicable laws.
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Telephone Operations

The NexPath Telephony Server allows operations such placing calls on hold, transferring a call, and setting
up conference calls to be controlled from any telephone connected to the system. This chapter describes the
operations available and how to control them. Note, though, that all of the operations described in this chapter can also be performed from a Windows 95/98/NT computer if the computer is connected to the NexPath
Telephony Server through a TCP/IP network connection, and the program NexDial is installed. Some operations are also available from NexDirector. Also, Windows and non-Windows machines connected to the
network and running Netscape Navigator 3.03 (and certain subsequent versions) can run TelOper, a webbased desktop call control program. See CHAPTER 4:Windows Desktop Tools- NexPath Dialer starting on
page 59 and CHAPTER 6:TelOper: the Web Browser Desktop Interface starting on page 89 for details.
Also, all voice mail operations can be performed from either a telephone or a computer. However, the key
sequences described in this chapter for call control from a telephone will be unavailable while you are
actively retrieving voice mail from a telephone. For details on voice mail operation, see CHAPTER 3:Voice
Mail starting on page 47.

General Concepts
Below is a list of topics which are common to the commands described throughout the rest of this chapter.
Please take the time to read this information before proceeding to the actual commands available in the NexPath Telephony Server.
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Hook-flashes
Hook-flashes are one of the more complicated operations needed in the NexPath Telephony Server. The reason we need them, though, is that if you press the keys on your telephone keypad while in the middle of a
normal call, the NexPath Telephony Server simply passes these key presses on to the other party. This is
handy when the other party’s phone system can do something with them, such as route your call to an extension within their building, but it makes it difficult to signal the NexPath Telephony Server that you want to
do something special like put a call on hold once you are in the middle of a call.
Some telephone systems solve this problem by requiring that you use special keys on their proprietary
phones (sometimes misleadingly called digital phones). The problems with special phones are that they are
expensive, they only work on one system, they become obsolete quickly, and they often do not have otherwise commonly available features such as speed-dial.
On the NexPath Telephony Server, you can signal the system that you want to do something special like put
a call on hold while in the middle of a call by performing a hook-flash, then entering the command sequence
for the operation desired. Hook-flashes are done by quickly depressing and releasing the hook switch1 on
your phone, or by pressing the flash key on your phone.
Note, though, that perfecting the art of performing hook-flashes using the hook-switch might take a little
practice. You must depress the switch for long enough to make it obvious to the system that you want to signal it but not so long that the system thinks you hung up. A valid hook-flash is accomplished by depressing
the telephone hook switch for an interval of greater than 50 milliseconds and less than 800 milliseconds (a
millisecond is 1/1000ths of a second, so 800 milliseconds is a little over 3/4 of a second).
Some phones come with a Flash button which performs the hook-flash function. Care must be used with
telephones that have this button, however, since they can issue a hook-flash for a full 3/4 of a second, which
is a fairly long time. If you begin entering other keys of a sequence before the pre-programmed flash time
has ended, many older phones will block the subsequent tones, and the NexPath Telephony Server will not
“hear” these other keys and you will likely get an error message.
Test the telephones you are using, and, if the telephone does not queue the keys, make sure you have waited
until the preprogrammed flash time is over before pressing other keys. Or, better yet, if you have one of

1. The hook-switch is the switch that gets depressed by the handset when you hang up your phone.
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these older phones, learn how to depress and release the hook-switch properly by hand instead of using the
Flash key1.
Note

Many telephones are now being produced that properly queue other keypad keys after the the flash key,
so that it can be depressed along with the other keys at any rate. In particular, the the flash key on the
Nortel 9316 (the flash key is called LINK on the Nortel phone) and the Panasonic KX-TSC50
telephones works properly with the NexPath Telephony Server.

In this manual, we will designate a hook-flash with the symbol Flash .

Beeps and rings
You will hear one short beep in your conversation if you are on the phone and you leave another call on hold
for too long2. You can use the Swap Hold sequence Flash * (i.e., performing a hook-flash followed by
pressing the * button on your telephone) to toggle between your existing call and the call on hold.
Note

If you are not on the phone and you leave a call on hold too long, you will receive a short ring on your
phone, but when you pick up the phone, no one will be there. You can retrieve this call from hold using
the Retrieve Call From Hold sequence * 1 .

Two short beeps in your conversation indicates that you have a call waiting. You can put the current call on
hold and pick up the new call using the Pick up Waiting Call sequence Flash 3 . You can then use the
Swap Hold sequence Flash * to toggle between the two. Note that if you are done with your current call,
you can still use Flash 3 to pick up the incoming call. The pre-existing call you put on hold with the
Flash 3 will disappear when the person you were talking to hangs up.

1. If you program a sequence into a phone with speed-dial, and Flash is programmed as one of the keys in the programmed sequence, the phone will automatically wait until the end of its own flash time before issuing the other keys in
the sequence. Therefore, this 3/4 second blanking time is not a problem for flash sequences programmed into a speeddialer.
2. This delay time is usually 45 seconds. However, the reminder ring delay time can be changed by your system administrator, and might be set differently for your system.
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You will hear three short beeps if you are on the phone and someone uses the barge-in sequence to break into
your conversation.

Call distribution groups
Your system administrator may configure your system’s auto-attendant to support call distribution groups,
that is, groups of extensions which represent entire departments, such as Sales or Marketing. When a caller
calls in, they are given a message such as “Press 1 for Sales, 2 for technical support...”
When the caller presses one of these selections, the call is routed to the call distribution group defined for the
selection, and each extension within the call distribution that is accepting calls (see Accept Calls on page 10)
will ring in sequence. The exact ring sequence for the group and what happens if no one picks up the call is
determined by the system administrator when the call distribution group is configured.

Ring groups and Pickup groups
Your system administrator can assign a ring group number to any group of physical telephone lines. This
function is normally used so that a ringing phone can be picked up from another phone using the Pick Up
Group sequence * 0 , followed by the ring group number. It is also used to cause a group of phones to ring
at the same time, so that any one of the phones can be answered to accept the call.
By factory default, ring group 0 is defined as all phones in the system except the PA speaker. This means that
you can usually pick up any ringing phone in the building by entering * 0 0 .
Also by factory default, ring group 1 is defined as containing the telephone line which rings through your
company’s overhead PA speaker. Unless your system administrator has changed the definition of ring group
1, you can pick up a call ringing over the overhead PA speaker by picking up any phone and pressing
* 0 1.
Ring groups can also be assigned to extensions by the system administrator, so that when the extension number is dialed, several telephones ring at the same time. Any one of the telephones can be answered to receive
the call; the first telephone in the ringing group of extensions that goes off hook gets the call, the others get
dial tone.
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Extensions numbers in the NexPath Telephony Server
There are eight different types of extensions in NexPath system:
1.
2.
3.
4.
5.
6.
7.
8.

Inside line extensions (default is 300-399)
Outside line extensions (default is 200-299)
Voice mailbox extensions (default is 500 -599 and 130-131)
Auto-attendant extensions (pre-configured as 120 (Day Program) and 121 (Night Program))
Park orbit extensions (default is 100 - 110)
Speed dial extensions (none predefined)
Public address extensions (special case of #2, default is 111).
Extensions that ring several phones at once (special case of #1, none predefined)

Any of these extensions types can be directly dialed from a telephone. The resulting function will be determined by the system programming for that extension type, i.e., you will ring a phone, seize an outside line,
enter voice mail, execute an auto-attendant program, etc.
The concept of extension numbers and their symmetric use throughout the system is a very powerful feature
of the NexPath Telephony Server.

System speed dial numbers
Your system administrator can program the NexPath Telephony Server to recognized special three digit
numbers, called speed dial extensions, that translate to 7 or more digit off-site numbers. These can be used
for convenient direct dialing, or for convenience in transferring calls.
Contact your system administrator to determine if any speed dial extensions have been configured for your
system.
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Accept Calls/Do Not Disturb
Accept Calls * 8
Do Not Disturb * 9
Whenever the NexPath Telephony Server is powered up, your extension will automatically be placed in the
Accept Calls mode, which means that your phone will ring when someone calls you.
You can place your extension in the Do Not Disturb mode, though, during which calls made to your extension will go directly to your voice mail or directly to the number you specify as a forwarding number without first ringing at your extension1. You may want to place your extension in the Do Not Disturb mode when
you are in a meeting and do not want your phone to ring or when you are out to lunch and do not want someone else to pick up your phone.
If your extension is part of a call distribution group and you place your phone in the Do Not Disturb mode,
then calls to the distribution group (Sales, for example) will not ring at your phone, but instead will go on to
the next extension in the group. Calls placed by dialing your extension number directly, however, will be
routed as described above.
To put your extension in the Do Not Disturb mode:
1.
2.
3.
4.
5.

Pick up any phone or otherwise get an inside line dial tone.
Enter the Do Not Disturb sequence * 9 .
Enter your extension number.
If prompted, enter your password2, or a password with administrator privileges.
If your password was accepted, you will be notified that your extension has been placed in the Do Not
Disturb mode.
6. Hang up.

1. If your extension has not been configured to support voice mail and you have not set up call-forwarding for your extension, your phone will ring even if you place it in the Do Not Disturb mode.
2. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.
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To return your extension to the Accept Calls mode:
1.
2.
3.
4.
5.
6.
Note

Pick up any phone or otherwise get an inside line dial tone.
Enter the Accept Calls sequence * 8 .
Enter the number of the extension you wish to change to Accepting Calls.
If prompted, enter your password1, or a password with administrator privileges.
If your password is accepted, you will be notified that your extension is now accepting calls.
Hang up.
There is no indication at your phone whether your extension is in the Accept Calls mode or the Do Not
Disturb mode. If you want to be sure to receive calls, you can enter the Accept Calls sequence at any
time, even if your extension is already in the Accept Calls mode.

1. You will not be asked for a password if you entered it to enable some other command and have not hung up since then.
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Barge In
Barge In # 2
Barge-in is the process of breaking into a conversation. To barge into your own voice mail extension, for
example, while someone is leaving you voice mail:
1.
2.
3.
4.
5.
Note

Pick up any phone or otherwise get an inside line dial tone.
Enter the Barge-in sequence # 2 .
Enter the number of your voice mail extension.
If prompted, enter your password1, or a password with administrator privileges.
If your password is accepted, you will be connected to the person currently leaving you a message.
If your phone is still ringing, you can usually pick up the call from any other telephone in the building
by picking up a phone and entering the Pick Up Ring Group 0 sequence * 0 0 .

If your system administrator has given your account Barge-in/Listen-in permissions, you can also use the
sequence described above to barge into other people’s conversations while they are on the phone. Check
with your system administrator to see if you have barge-in permission. You do not need Barge-in/Listen-in
permission to barge-in to voice mail in progress in your own voice mail boxes.
Note

When you barge into an existing conversation, the party at the extension number you barged into will
hear three short beeps, indicating that someone is barging into his or her call.

WARNING: Barge-in permissions also allow Listen-in. Listening-in to a conversation
without the consent of one or both parties may be a violation of local, state, and federal
privacy laws. It is the responsibility of the user of the NexPath Telephony Server, when
using features of the system, to assure that they are in compliance with all applicable
laws.
1. You will not be asked for a password if you entered it to enable some other command and have not hung up since then.

12

Telephone Operations

Call Forwarding
Forward Calls * 2
Cancel Forwarding * 3
You can forward your calls to ring at any extension on the NexPath Telephony Server. To set up call-forwarding:
1.
2.
3.
4.

Pick up any phone or otherwise get an inside line dial tone.
Enter the Forward Calls sequence * 2 .
Enter your extension number.
Enter the number (either an extension or an off-site number) to which you want your calls forwarded, followed by the # key, or wait four seconds.
5. If prompted, enter your password1, or a password with administrator privileges.
6. If your password was accepted, you will be notified that call-forwarding has been enabled, followed by
the announcement of the forwarded number (i.e., you can verify that the number you entered is correct).
7. Hang up.
Note

You do not have to enter a 9 to seize an outside line, if you are forwarding your calls offsite. The
system automatically seizes an outside line if the number is seven or more digits. However, you must
enter a one if it is a long distance number. Outside calls that are forwarded offsite may have reduced
quality and reduced audio levels.

When you enable call-forwarding for your extension, an incoming call will ring at your phone for 20 seconds before being forwarded2. The call will then ring at the forwarding extension for 20 more seconds. If,
after this additional 20 seconds, no one has picked up the call and you have an exit extension (such as a
voice mailbox extension) associated with your extension, the call will go to the exit extension. That is, the
call will eventually go to the exit extension of the original extension the caller dialed.

1. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.
2. These are the factory-default forwarding and ringing delay times. Your system administrator can alter both of these times.
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If the extension is forwarded to a speed dial extension, and the speed dial number does not answer, the call
will go to the exit extension programmed in the speed dial extension configuration.
On the other hand, if you do not have an exit extension programmed, after the forwarding phone rings for its
additional 20 seconds, the caller will be notified that there is no one to take the call and will be disconnected.
Calls that are forwarded offsite (not using speed dial extensions) are monitored by the NexPath Telephony
Server, and the system will attempt to determine if a caller has answered. If not, the call will go to the exit
extension (such as voice mail), if the exit extension has been configured for the extension that was forwarded. However, the monitoring of the progress of calls to outside lines depends on the ability to detect
call progress sounds on the telephone line. This is not a precise process and it may not be successful in all
cases. There can also be a delay before the call is connected.
Offsite forwarding will use Centrex or CLASS features (hook-flash transfers) if the CO line involved has
been designated as a Centrex or CLASS line.
Calls forwarded to a speed dial extension are handled differently. If an extension is forwarded to a speed
dial number, then the call progress monitoring is handled as specified in the speed dial extension configuration. The system will not attempt to determine if the call connects unless so designated in the speed dial
setup. The exit extension as specified in the speed dial extension setup is used if the call fails to complete.
Speed dial extensions and exit extensions must be configured by your system administrator.
Note

An extension can only be forwarded once.

Call forwarding for your extension will remain in effect until you cancel call forwarding. To cancel call forwarding:
1.
2.
3.
4.
5.

Pick up any phone or otherwise get an inside line dial tone.
Enter the Cancel Forwarding sequence * 3
Enter your extension number.
If prompted, enter your password1, or a password with administrator privileges.
If your password was accepted, you will be notified that call-forwarding has been cancelled.

1. You will not be asked for a password if you entered it to enable some other command and have not hung up since then.

14

Telephone Operations

6. Hang up.

15

User’s Guide

Call Waiting
Enable Call Waiting * 4
Pick up a Waiting Call Flash 3
Swap Between a Current Call and a Call on Hold Flash *
Cancel Call Waiting * 5
When call-waiting is enabled for your extension, you will hear two beeps in your conversation when you are
on the phone and a new call comes in1. When you hear these two beeps, you can decide whether to put your
current caller on hold and take the new call, or continue talking to your current caller and, depending on how
you extension is set up, let the new caller go to either your voice mail, get forwarded, or be disconnected.
You can eliminate call-waiting beeps from your conversations by disabling call-waiting for your extension.
To enable call waiting at your extension:
1.
2.
3.
4.
5.
6.

Pick up any phone or otherwise get an inside line dial tone.
Enter the Enable Call Waiting sequence * 4 .
Enter your extension number.
If prompted, enter your password2 or a password with administrator privileges.
If your password was accepted, you will be notified that call-waiting has been enabled.
Hang up.

If you enable call waiting for your extension and you are on the phone when another call comes in, you will
hear two short beeps in the middle of your existing call. You can press Flash 3 to put the current call on
hold and answer the new call, or you can ignore the new call and let it go to your voice mail.
Note that if you pick up the incoming call, you can use the Swap Hold sequence Flash * to toggle
between the two calls.

1. Your caller will not hear these beeps, only you will.
2. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.
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To disable call waiting at your extension:
1.
2.
3.
4.
5.
6.

Pick up any phone or otherwise get an inside line dial tone.
Enter the Disable Call Waiting sequence * 5 .
Enter your extension number.
If prompted, enter your password1, or a password with administrator privileges.
If your password was accepted, you will be notified that call-waiting has been disabled.
Hang up.

The NexPath Telephony Server’s default configuration allows a phone to ring 20 seconds before being forwarded, or 20 seconds before being sent to voice mail or getting disconnected, though your system administrator can alter these times. If you do not pick up a waiting call and you have set up call-forwarding for your
extension, a waiting call will forwarded after 20 seconds. If you do not have call-forwarding enabled but do
have a voice mailbox, then after 20 seconds the waiting call will go to your voice mailbox. If you have neither call-forwarding enabled nor voice mail, then after the 20-second delay time has expired, the caller will
be notified that there is no one to take the call and the call will be disconnected.

1. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.
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Clear
Clearing a Command Sequence # #
After getting an inside dial tone but before finishing a command sequence, you can get back to an inside dial
tone by pressing the Clear sequence # # .
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Conference Calls
Set Up Conference Flash 7
Add To Conference Flash 8
The NexPath Telephony Server can allow up to four parties to be conferenced on a single conference call,
with the four parties being any combination of inside or outside lines.
To initiate a conference call:
1. Call your first party. This could be either an inside or an outside number.
2. Enter the Set up Conference sequence Flash 7 . This will put your current call on hold and request a
conference circuit from the system. If a conference circuit is available, you will get an inside dial tone. If
no conference circuits are available, you will receive an error message and be re-connected to your first
call. Wait and try again later.
3. After getting a conference circuit and an inside dial tone, dial the number of the next party you wish to
conference in. This can include making calls to parties on either inside or outside lines. If you cannot get
your second party, retrieve your first call from hold using * 1 and try again later.
4. Upon reaching your second party, enter the Add To Conference sequence Flash 8 . You, your first
party, and your second party will all be talking to each other.
5. To add a fourth party to the conference, enter Flash 7 again. The first two callers will remain connected to each other, and you will receive an inside dial tone.
6. Dial the number of the next party you wish to conference in.
7. Upon reaching your third party, enter the Add To Conference sequence Flash 8 . You will be connected to all three callers.
8. You may hang up at any time and leave the conference active. The conference will end when no more
inside lines are involved in the call.
Note

You can obtain a conference circuit before calling your first party by skipping step 1 above.
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Day Ringing/Night Ringing
Enable Day Ringing # 0
Enable Night Ringing # 1
The NexPath Telephony Server has two modes of operation that affect both the ringing of all extensions and
the auto-attendant: Day Mode (day ringing) and Night Mode (night ringing). Each extension can programmed to ring at different lines or groups of lines when the system is switched from Day Mode to Night
Mode. For example, an extension may be programmed so that calls placed to it ring one particular phone
when the system is in Day Mode, but ring all the phones in an entire ring group when the system is in Night
mode so that anyone left in the building can pick it up.
The auto-attendant may also have a Day Mode program and a Night Mode program. A different message
and set of choices may be presented to the caller depending on whether it is during regular business hours or
after hours. All of these features depend on the configuration and setup that is done by the system administrator when the system is installed or configured.
To enable day ringing (and disable night ringing):
1.
2.
3.
4.
5.

Pick up any phone or otherwise get an inside line dial tone.
Enter the Enable Day Ringing sequence # 0 .
If prompted, enter your password1, or a password with administrator privileges.
If your password was accepted, you will be notified that day ringing has been enabled.
Hang up.

To enable night ringing (and disable day ringing):
1. Pick up any phone or otherwise get an inside line dial tone.
2. Enter the Disable Day Ringing sequence # 1 .
3. If prompted, enter your password2.
1. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.
2. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.
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4. If your password was accepted, you will be notified that day ringing has been disabled.
5. Hang up.
Note

Your system can configured to switch automatically between Day mode and Night mode. See your
system administrator for details on whether or not your system is configured to do so.
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Disconnecting
Disconnect Call Flash #
You can disconnect from a call without hanging up. Once you have entered a password, you may want to do
this to avoid losing password protection or perhaps for other reasons. If your are using an inside extension
that automatically seizes an outside line (sometimes called assumed dial nine), this sequence will disconnect
from the outside line and return inside dial tone.
To disconnect from a call, or to disconnect from an outside line and obtain inside dial tone, without actually
hanging up the phone:
1. Enter the Disconnect sequence Flash # .
2. You will receive an inside dial tone.
3. Enter a new command or the next number you want to dial.
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Do Not Disturb
See Accept Calls/Do Not Disturb
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Help
Help * *
To get a summary of all commands listed here from your phone:
1. Pick up any phone or otherwise get an inside line dial tone.
2. Dial the Help sequence * * .
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Hold
Put A Call On Hold Flash 1
Retrieve A Call From Hold * 1
Swap Between a Current Call and a Call on Hold Flash *
The NexPath Telephony Server can place up to three calls on hold at a time on any one extension. The calls
are place on a stack, much like a stack of boxes or books. The last call placed on the stack using Flash 1
is the first one retrieved when * 1 is entered. Calls place on hold at an extension can only be retrieved
from that extension (private hold). If you want to place calls on hold to be retrieved from any extension, use
park orbits (public hold). See Park Orbits on page 36 for a detailed description.
Calls placed on hold using the above sequences, or placed into park orbits, receive hold music, if enabled for
the line and external hold music is supplied to the system.
To place a call on hold:
1. Enter the Put Call On Hold sequence Flash 1 . You will get an inside dial tone, and are free to call a
new number, enter a command, or hang up.
Note

If you inadvertently leave a call on hold and forget about it, you will get a short reminder ring every 45
seconds1.

To retrieve the call most recently put on hold:
1. Pick up the phone or otherwise get an inside line dial tone at the phone where the call was put on hold.
2. Enter the Retrieve Call From Hold sequence * 1 . You will be connected to the call most recently put on
hold.

1. This is the factory default value for the reminder ring delay time. Your system administrator can alter this time if desired.
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To swap your current call with the call most recently put on hold:
1. Enter the Swap Hold sequence Flash * . Your current call will go to the top of the hold stack, and you
will be connected with the most recent caller put on hold.
To get at a call on the hold stack when more than one call is on the stack:
1. Get an inside line. If you are on a call, you can hang up on this call without putting down the handset by
entering Flash # . You can also transfer the current call using the Blind Transfer sequence Flash 4
or the Set Up Transfer and Complete Transfer sequences Flash 5 and Flash 6 respectively.
2. Take the most recent call which was placed on hold off of hold by entering the Retrieve Call From Hold
sequence * 1 .
3. Hang up or transfer this call.
4. Take the next call off of hold by entering the Retrieve Call From Hold sequence * 1 .
5. If necessary, hang up or transfer this call, and take the first call which was placed on hold off of hold by
entering the Retrieve Call From Hold sequence * 1 .
6. When done, hang up.
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Hook Flash the Central Office Line (Centrex and CLASSSM features)
Hook Flash the Central Office Line Flash 9
You can send a hook flash to the central office line, rather than have the hook flash interpreted by the NexPath Telephony Server. This is only useful if you have Centrex lines or CLASSSM features, such as three
way calling, enabled on your outside lines.
Note

The ability to hook flash a Central Office line can be enabled or disabled on a CO line by CO line basis
in the NexPath Telephony Server. This feature must be enabled with the administration software in
order for the sequence to work. Otherwise the sequence is ignored.

To send a hook flash to the central office line (see the note above):
1. While connected to an outside (central office) line, enter Flash 9 . You should receive the signal from
the central office that the sequence is recognized, usually three short beeps and then central office dial
tone.
For example, to setup a three way call using CLASSSM features:
1. While connected to an outside (central office) line and talking to the first party, enter Flash 9 . You
should receive the signal from the central office that the sequence is recognized: three short beeps and
then central office dial tone.
2. Dial the second party.
3. When you are connected, enter Flash 9 again. You should now have a three way call.
Note

You must subscribe to CLASSSM features from your telephone company in order to use the three way
calling described above.
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Inside Lines
When you first pick up your phone, the dial tone you hear is an “inside line” dial tone. This is a dial tone provided directly by the NexPath Telephony Server and not by the phone company. When you have an inside
line, the NexPath Telephony Server is ready to accept both phone numbers to be dialed and the key presses
of the command sequences for the advanced operations described in this chapter and in the chapter Voice
Mail starting on page 47.
Some notes: After getting an inside line dial tone, if you do not press any keys, you will get a dial tone timeout message after 90 seconds. Similarly, once you start dialing a phone number or command sequence, if
you wait more than 15 seconds between digits, the system will give you a keypad dialing time-out message
and then return you to an inside line dial tone. Also, if you make a call to another inside line and get a busy
signal and then forget to either hang up or otherwise disconnect from the call, you will get a busy signal
time-out message after 60 seconds1.
Often, the first thing you do after picking up your phone is dial 9 to get an outside line. Once you do this,
however, the NexPath Telephony Server stops trying to interpret all key presses except hook-flashes, as
described in the beginning of this chapter2. Not all commands start with hook-flashes, however, so it is
important to know how to get back to inside line dial tone. The easiest method is to hang up for a second or
two and then pick your handset again. Another way is to wait until the phone company decides that your
phone has been off-hook too long and disconnects you. This is similar to leaving a phone off-hook too long
at home, but instead of hearing silence and then the loud “beep-beep-beep” that the phone company usually
puts out, the NexPath Telephony Server detects this condition, hangs up the outside line, and returns you to
an inside line dial tone. Yet another method is to disconnect from your current call is to use the Disconnect
sequence Flash # .
Sometimes, it is desirable to get an inside dial tone from outside your facility, especially when you want to
check your voice mail from home or from another facility. To get an inside line dial tone from outside your
building:
1. Dial your company and wait for your system to pick up.

1. These are factory default times, and can all be altered by your system administrator.
2. If your system is configured to perform area code lockouts, the NexPath Telephony Server will also check that the inside
line being used has permission to obtain an outside line, and that the area code being dialed is allowed for that line.
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2. During your company’s auto-attendant greeting, dial the number specifically set up by your system
administrator to give you an inside dial tone.
If you do not know the correct number to dial during the auto-attendant answering sequence, you can still
get an inside dial tone by doing the following:
1. Dial your company and wait for your system to pick up.
2. During your company’s auto-attendant greeting, dial your own voice mail extension number.
3. When you hear your pre-recorded greeting, hit the # key, then enter your password. You will be in voice
mail at this point, and if your intention was to check your voice mail, then you are ready to press 1 for
Play, 2 for Pause, etc., as outlined in the chapter Voice Mail starting on page 47.
If, on the other hand, you really need an inside line dial tone to perform some other function such as enabling
call-forwarding for your extension or putting your system in Night Mode, then once you are in your voice
mail, press * (at this point, * is the Exit Voice Mail sequence), and you will get an inside dial tone.
Once you get an inside line dial tone from an outside line, you can perform all of the functions you would
from inside the building EXCEPT pressing 9 to get an outside line dial tone. This is done to prevent users
from dialing in from outside and then placing long-distance calls which get charged to the company.
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Line and Extension Numbers
Announce Line Number and Extensions # 8
The Announce Line and Extension Number sequence # 8 is primarily of value when performing system
administration of the NexPath Telephony Server. The system will announce the physical line number and all
extension numbers associated with any telephone from which the sequence is entered.
# 8 can also used for performing system administration from a telephone. If you use # 3 and enter a
password with system administrative permissions and then press # 8 after the password is accepted, you
will get a list of all user numbers and their passwords (see the NexPath Telephony Server System Administration Guide for details on user numbers).
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Listen In
Listen In # 5
Listen-in is the process of monitoring a conversation without notifying the participants. You can also listen
in (screen) voice mail in progress.
To listen into your own voice mail extension, for example, while someone is leaving you voice mail:
1.
2.
3.
4.
5.
6.

Pick up any phone or otherwise get an inside line dial tone.
Enter the Listen-in sequence # 5 .
Enter the number of your voice mail extension.
If prompted, enter your password1, or a password with barge-in privileges.
If your password is accepted, you will be listening to the person currently leaving you a message.
If you want to Barge-in (take the call), enter Flash . The voice mail recorded up to that point will be
saved, the recording will terminate, and you will be connected to the caller.

If your system administrator has given your account Barge-in/Listen-in permissions, you can also use the
sequence described above to listen into other people’s conversations while they are on the phone, for quality
control and monitoring purposes. Check with your system administrator to see if you have Barge-in/Listenin permission.
You do not need Barge-in/Listen-in privileges to listen in to voice mail in progress on your own voice mail
boxes.

WARNING: Listening-in to a conversation without the consent of one or both parties
may be a violation of local, state, and federal privacy laws. It is the responsibility of the
user of the NexPath Telephony Server, when using features of the system, to assure that
they are in compliance with all applicable laws.

1. You will not be asked for a password if you entered it to enable some other command and have not hung up since then.
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Night ringing
See Day Ringing/Night Ringing
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Operator
Dial the operator 0
To reach the operator from inside your company:
1. Pick up any phone or otherwise get an inside line dial tone.
2. Dial 0 .
3. The operator’s phone will ring.
Your system administrator will set up a normal extension number as the operator’s extension. Dialing 0
from an inside line is a shortcut for dialing this extension, though you can get the same result by dialing the
full extension number. Your system administrator can configure your system so that if the operator is busy or
does not answer, your call will go to the auto-attendant.
Note

Both inside and outside callers will get an entry error message if they try to dial 0 (or, for that matter,
any other number) while ringing an inside line. To get back to the operator, they will need to allow
voice mail to pick up, then press 0 .
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Outside Lines
Obtain an Outside Line 9
You will get an inside dial tone when you lift your telephone handset unless your extension has been specially set up otherwise. Once you have an inside line dial tone, to get an outside line:
1. Pick up any phone or otherwise get an inside line dial tone.
2. Dial 9 .
Note

You will get a busy signal if you dial 9 and all of the outside lines connected to your system are busy.

Your NexPath Telephony Server can be programmed to block dialing specific area codes from specific
phones or groups of phones. If you try to dial an area code that has been blocked on the phone you are using,
you will be disconnected and hear an error message, then get an inside dial tone.
On the other hand, your system administrator can assign you your own set of area code lockouts and permissions. To override the area code lockouts on a particular phone with the area code permissions you have been
assigned personally:
1.
2.
3.
4.
5.
6.

Pick up any phone or otherwise get an inside line dial tone.
Enter # 3 . The system will ask you for your password.
Enter your password.
If your password was accepted, you will get a voice prompt and another inside dial tone.
Enter 9 .
After receiving an outside dial tone, dial the long distance number desired.

Check with your system administrator to determine the area code lockouts and permissions in place in your
system.
Note
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Paging (Public Address)
If your system is connected to a PA system, your system administrator can configure one extension per card
as the paging extension1. When you dial this extension, you will be connected to the PA system and can
make announcements (For example, “Jim Williams, please dial 455.”).
To make an announcement:
1.
2.
3.
4.

Pick up any phone or otherwise get an inside line dial tone.
Dial the paging extension number.
Begin speaking.
Hang up when done.

1. The factory default number for the paging extension is 111. An external amplifier is required (not supplied).
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Park Orbits
Calls on the NexPath Telephony Server may be put on hold such that any caller can pick them up. This type
of public hold is called a park orbit. Park orbits are essentially a special type of extension, one which does
not ring anywhere, and anyone can pick up.
Park orbits are useful in a company where a call must be put on hold, and a PA (Public Address) system is
available to notify the called party to pick up the call. By putting the call in a park orbit, the called party can
answer the call anywhere in the building.
Calls in park orbits receive hold music, if enabled for the line and external hold music is supplied to the system.
A call is placed in a parking orbit in the same way that it is transferred to a regular inside line extension. To
put a call in a parking orbit:
1. While connected to the party, enter the Blind Transfer sequence Flash 4 .
2. Enter the desired park orbit extension number.
3. If your transfer was successful, you will hear a prompt telling you that the call was transferred and the
caller will be put on hold. If the park orbit you dialed is busy, you will get a busy tone and be reconnected
to your caller.
To announce that the call is on hold over the PA system:
1.
2.
3.
4.

Get an inside dial tone.
Dial the paging extension configured for your system (the factory default is extension 111).
Make your announcement.
Hang up.

To retrieve a call from park orbit:
1. Pick up any phone or otherwise get an inside line dial tone.
2. Dial the desired park orbit number.
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Note

Calls left in a park orbit too long will cause a reminder ring (a single, short ring) to be sent to the
originating extension every 45 seconds1.

Your system administrator will reserve a specific set of consecutively-numbered extensions as park orbits2.

1. This is the factory default reminder ring delay time. Your system administrator can alter this time.
2. The factory default is to use extension numbers 100 to 110 as the system’s park orbits, though your system administrator
can alter this.
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Passwords
Enter Password # 3
Change Password # 4
Passwords are required for a number of the operations described in this chapter, as well as for accessing
voice mail. Each user is assigned a unique password. When you enter your password, you identify yourself
to the system. This allows the system to block unauthorized users from forwarding your calls, retrieving
your voice mail, for example.
Note

The factory-default configuration is for all passwords to be four digits long.

Once you enter a password, the system will know who you are and you will remain “under password protection” until you hang up. This means that any further operations you may want to perform which require a
password can be done without re-entering a password.
If you attempt to perform an operation which requires a password and you have not already “gone under”
password protection, the system will prompt you for a password. If this happens, enter your password at the
prompt to complete the operation. You will then be “under password protection” from then until you hang up
the phone.
In addition, you can also “go under password protection” by doing the following:
1.
2.
3.
4.
5.

Pick up any phone or otherwise get an inside line dial tone.
Enter # 3 . The system will ask for a password.
Enter your password.
If your password was accepted, you will get a voice prompt and another inside dial tone.
Perform the operation desired. Note that, instead of hanging up, you can finish one operation and start
another by using the Disconnect sequence Flash # .

To change your password:
1. Pick up any phone or otherwise get an inside line dial tone.
2. Enter the Change Password sequence # 4 . The system will ask for the old password.
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3. Enter your old password. The system will ask for the new password
4. If the old password was valid and the new password was accepted, you will get a voice prompt saying the
password has been changed.
Note

Some passwords are reserved for system use only. You will get an error message if you attempt to use
the Change Password sequence # 4 to change your password to one of the reserved passwords.

Your system administrator is in charge of assigning all passwords and permissions. In addition to allowing
you to access your voice mail and perform basic telephone operations, your system administrator can assign
you permission to:

• Change the system mode from Day Mode to Night Mode and back again.
• Override the area code lockouts in place on a particular phone with your own set of area code permissions
and lockouts.
• Barge into or Listen into other people’s calls.
• Perform system administration functions.
Ask your system administrator about the password and permissions you have been assigned.
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Pick up
Pick Up Ring Group * 0
Pick Up Any Ringing Phone * 0 0
Pick Up Ringing Speaker * 0 1
Your system administrator can group telephones together into ring groups (also called pickup groups). See
the section entitled Ring groups and Pickup groups on page 8 for details.
To pick up a ringing phone within a ring group from a phone that is not ringing:
1. Pick up any phone or otherwise get an inside line dial tone.
2. Enter the Pick Up Ring Group sequence * 0 , followed by the single digit representing the ring group.
You will be connected to the caller ringing the phone.
By factory default, ring group 0 is defined as the group of all extensions except the PA speaker. This means
that to pick up any ringing phone in your building, you can:
1. Pick up any phone or otherwise get an inside line dial tone.
2. Enter * 0 0 . You will be connected to the caller ringing the phone.
Note

Check with your system administrator to see how this ring group is defined for your system.

Also by factory default, ring group 1 is defined as containing the extension which rings over to the PA system. This means that, if you hear a ringing phone over your PA system (usually a system is configured so
that this happens for incoming calls when the system is in Night Mode), to answer it, you:
1. Pick up any phone or otherwise get an inside line dial tone.
2. Enter * 0 1 . You will be connected to the caller ringing the phone.
Note
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Transferring Calls
Direct (Blind) Transfer Flash 4
Set Up Transfer Flash 5
Complete Transfer Flash 6
A direct (or blind) transfer is when you transfer a call to another extension without first checking at that
extension to see if the party is available. Calls may be blind transferred to any extension, including park
orbits, voice mail extensions, or the operator.
To perform a direct (blind) transfer:
1. While connected to a caller, enter the Direct (Blind) Transfer sequence Flash 4 .
2. Enter the number of the extension to which the call is to be transferred.
3. If your transfer was successful, you will get a confirmation message, followed by an inside dial tone.
Note

If you perform a blind transfer to an extension that has voice-mail but no one picks up, then after 20
seconds the call will go to that extension’s voice mail. However, if you perform a blind transfer to an
extension that does not have voice mail and no one picks up, then after 20 seconds the caller will be
notified that no one is there to take the call and the call will be disconnected1.

4. If your call was unsuccessful (the extension dialed was invalid, for example), you will receive an error
message and be reconnected to your call.
Another type of transfer is Transfer with Consultation. This type of transfer allows you to find the person
you want to transfer the call to and notify them that a call is coming.
To perform a Transfer with Consultation transfer:
1. While talking the caller, enter the Set Up Transfer sequence Flash 5 .
2. You will get an inside dial tone and the caller will be put on hold.
3. Dial an extension, or a succession of extensions, to locate the party you wish to contact.
1. These are the factory-default ring delay times; your system administrator can alter this time if desired.

41

User’s Guide

4. When you have the desired party on the line, enter the Complete Transfer sequence Flash 6 .
5. The two parties will be connected. You will be disconnected from the call and will hear an inside dial
tone.
Note

If you cannot reach the second party or the other party does not want the call, you can retrieve the
original caller from hold using the Retrieve Call From Hold sequence * 1 .

If you set up a transfer but do not complete it, and then forget that the party is on hold, you will get a short
reminder ring every 45 seconds1. You can retrieve a call from hold using * 1 .
If, after setting up a transfer using Flash 5 , you decide to make the call a conference call instead of completing the transfer, you can use the Add to Conference sequence Flash 8 instead of the Complete Transfer sequence Flash 6 and you, the party you put on hold, and the person to whom you were going to
transfer the call will be connected together.

1. This is the factory default reminder ring time, and can be altered by your system administrator.
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Summary of the keypad sequences
Accept Calls/Do Not Disturb
•

Accept Calls

* 8

•

Do Not Disturb

* 9

Barge-in (See also Listen-in)

# 2

Call Forwarding
•

Forward Calls

* 2 nnn.. #

•

Cancel Call Forwarding

* 3

Call Waiting
•

Enable Call Waiting

* 4

•

Pick Up a Waiting Call

Flash 3

•

Swap Between a Current Call and a Call on Hold

Flash *

•

Disable Call Waiting

* 5

Clearing a Command Sequence

# #

Conference Calls
•

Set Up Conference

Flash 7

•

Add To Conference

Flash 8

Day Ringing/Night Ringing
•

Enable Day Ringing

# 0

•

Enable Night Ringing

# 1

Disconnect From a Call
Help

Flash #
* *
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Hold
•

Put a Call On Hold

Flash 1

•

Retrieve a Call From Hold

* 1

•

Swap Between a Current Call and a Call on Hold

Hook Flash to Central Office Line

(Centrex/CLASSSM)a

Inside Line (Disconnect from CO line)

Flash *
Flash 9

Flash #

Line and Extension Numbers
•

Announce Line and Extension Numbers

Listen-in (Screen Voice Mail) See warning

# 8

belowb

•

Listen in to a call or voice mail in progress

# 5

•

Barge-in after listening

Flash

Operator
•

Dial the Operator

0

Outside Lines
•

Obtain an Outside Line

9

Paging
•

Default extension number for paging

111

Park Orbits
•

Default park orbit extension numbers

•

Transfer to a park orbit

100 - 110
Flash 4

Passwords
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•

Enter Password

# 3

•

Change Password

# 4

Telephone Operations

Pick Up
•

Pick Up Ring Group

* 0

•

Pick Up Any Ringing Phone

* 0 0

•

Pick Up Ringing Speaker

* 0 1

Transferring Calls
•

Direct (Blind) Transfer

Flash 4

•

Set Up Transfer

Flash 5

•

Complete Transfer

Flash 6

a. This feature must be enabled for the Central Office line you are using with AdminTool. See The NexPath Telephony Server System Administration Guide.
b. WARNING: Listening-in to a conversation without the consent of one or both parties may be a violation of local, state, and federal privacy laws. It is the responsibility of the user of the NexPath Telephony Server, when using features of the system,
to assure that they are in compliance with all applicable laws.
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CHAPTER 3

Voice Mail

The NexPath Telephony Server includes a complete integrated voice mail system, essentially allowing each
user of the NexPath Telephony Server to have his or her own answering machine.
Each user can be assigned his or her own voice mailbox. Each voice mailbox can be associated with one (or
more) normal (voice) extensions and is assigned its own, unique extension number so that it can be dialed
directly.
You can access your voice mail from any telephone either inside or outside your building by dialing your
voice mail extension number, or, if the system is connected to a network, by accessing your voice mailbox
from a computer. See Chapter 4: Windows Desktop Tools- NexPath Dialer starting on page 59 and Chapter
6: TelOper: the Web Browser Desktop Interface starting on page 89 for details on accessing your voice
mailbox from a LAN connected computer.

Determining if you have new messages in your voice mailbox
You have a new message or messages if you pick up your telephone and hear a “on-off-on” or “stutter” dial
tone, for a few seconds, instead of the normal, steady dial tone.
If you have a telephone with a voice message light, one that is compatible with the VMWI or FSK signalling
technique, then the voice message light will also be illuminated, indicating new messages.

47

User’s Guide

Accessing voice mail from your telephone
To get into your voice mailbox:
1.
2.
3.
4.

Pick up any telephone in the system.
Enter your voice mailbox extension number (as assigned to you by your system administrator).
During the playing of your greeting, press the # key on your telephone.
Enter your password when prompted. If you make a mistake, you can press # and start re-entering your
password, or press * and return to your greeting.
5. If your password is accepted, you will be placed “in voice mail”, and the system will announce the number of new and old messages in your mailbox, or tell you that there are no new messages. Note that, even
if the announcement says you have no new messages, you can still play any old messages in your mailbox by following the instructions presented below for playing back messages.
When you are “in voice mail”, there are two menus that you can access, the Main Menu and the Message
Menu. If you have unread messages, then you directly enter the Message Menu, as show in Figure 3-1
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below. Or, if you press 1 from the Main Menu, you will reach the Message Menu. When in the Message
Menu of voice mail, the buttons on your telephone will have the following meanings

MESSAGE MENU
1
PLAY
CURRENT
MESSAGE

2

3

PAUSE/
RESUME

CALL PERSON
WHO LEFT
MESSAGE

4

5

6

FORWARD
MESSAGE

BACK
5 SECONDS

FORWARD
5 SECONDS

7

8

9

FOWARD
TO
GROUP

PREVIOUS
MESSAGE

NEXT
MESSAGE

*

0

#

EXIT
VOICE MAIL

DELETE
CURRENT
MESSAGE

RETURN TO
MAIN MENU

FIGURE 3-1. Telephone keypad when in voice mail: Message Menu

Note

The Forward to Group function (show in light grey) is not implemented in Software Release 5. It will
be implemented in a future release of the software.

When you press 1 from the Main Menu, and there are messages in your voice mail box, then the first message will begin playing immediately.
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If you do not have any unread messages when you enter voice mail, or you press # from the Message
Menu, you will be at the voice mail Main Menu. When in the Main Menu of voice mail, the buttons on
your telephone will have the following meanings:

MAIN MENU
1

2

3

GO TO
MESSAGE
MENU

SET NORMAL/
ALTERNATE
GREETING

PLAY
GREETING

4

5

6

RECORD
GREETING

PLAY
NAME

RECORD
NAME

7

8

9

CHANGE
PAGER
NUMBER

ADD
GROUP

SEND
MESSAGE
TO GROUP

*

0

#

EXIT
VOICE MAIL

REMOVE
GROUP

HELP

FIGURE 3-2. Telephone keypad when in voice mail: Main Menu

Note

While you are “in voice mail”, the buttons on your phone function will only perform the functions
described above. The other telephone system control sequences described in Chapter 2: Telephone
Operations starting on page 5 are not functional while you are in this mode. You can exit voice mail at
any time either by hanging up or by pressing the Exit Voice Mail key * , at which time you will hear an
announcement that you are exiting voice mail and then an inside line dial tone.

Note

The Add, Remove, and Send to Group functions (shown in light grey) are not implemented in Software
Release 5. These functions will be implemented in a future release of the software.
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To play back the messages in your voice mailbox:
1. Get into voice mail for your extension, as described above.
2. If there are new messages, the first message will begin playing immediately. Otherwise, press the Play
key 1 to begin playback of the first message in your mailbox. Message are sorted into two groups,
unread messages, and messages that have been listened to. For each group, note that playback will start
with the oldest message in your mailbox for that group. The messages are played back oldest first followed by the next, and finally the most recent message (in each group). Once a message has been listened to, it moves from the unread group to the listened-to group, and is placed in time order for that
group. The unread message group is played first, followed by the listened-to message group.
3. Use the keys on the telephone keypad as defined in the Message Menu diagram above (Figure 3-1) to
pause, resume, skip forward 5 seconds, jump back 5 seconds, delete, or proceed to the next or previous
message.
Note

After playback of the first message completes, the second message will not start playing until you press
the Next key 9 , or the delete key 0 to delete the message. If you wait a few seconds after a message
has completed, you will get a voice prompt to help you with the key assignments.

Forwarding a message to another mail box
While playing a message, or after a message has completed playing, you can forward the message to another
mailbox by pressing 4 , and entering the mailbox extension number when prompted of the mailbox to
which to forward the message. The message will be prepended with your Short Name, or your extension
number, as described below in “Recording a short name” on page 55.

Call the person who left a message
Callers can enter a call back number by pressing 1 then 7 after leaving a message. You can dial the call
back number of a person who left a message by pressing 3 while the message is playing, or after the message has completed playing. Dialing the call back number will dial the number left by the caller, or will dial
the caller ID of the caller, if available. If the caller ID is dialed, then 11 digit calling is used, starting with a
1 followed by the area code and number. Otherwise, the call back number is dialed exactly as entered by the
caller, with no other digits prepended.
You can return to voice mail after dialing the call back number by pressing the # key.
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Getting a help message during voice mail
Whenever you are in the voice mail Message Menu or the Main Menu and you pause for a short time, the
system will prompt you with a voice message explaining the meaning of the telephone keys with regards to
voice mail operations.
You can get help while your are in voice mail as follows:

•
•
•
•

Enter the voice mail Main Menu and doing nothing for a few seconds.
Touch the Pound key # while in the Main Menu.
Touch the Pound key # while in the Message Menu.
Pause a message (in the Message Menu) with the pause key 2 and then wait a few seconds.

To record your standard or alternate greeting
1. Get into voice mail for your extension, as described above, and assure you are in the Main Menu by hitting # .
2. Press the Record Greeting key 4 .
3. Then press 1 to record the standard greeting, or 2 to record the alternate greeting.
4. Wait for the “record greeting” voice prompt.
5. Record your greeting.
6. After you have finished speaking, hit any key to end recording your greeting.

To play back your standard or alternate greeting
1. Get into voice mail for your extension, as described above, and assure you are in the Main Menu by hitting # .
2. Press 3 (the Play Greeting key)
3. Then press 1 to play your standard greeting, or 2 to play your alternate greeting.
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To set your Standard Greeting or Alternate Greeting
You can choose between two greetings for your voice mail box. This is useful if you have a regular daily
greeting and a different greeting when you are out of the office. The Set Normal/ Alternate greeting key 2
toggles between these modes. To set you standard or alternate greeting do the follow:
1. Get into voice mail for your extension, as described above, and assure you are in the Main Menu by hitting # .
2. Press 2 to toggle the greeting mode between standard and alternate. The system will announce the setting: Standard or Alternate. It will stay in this mode until you hit 2 again from the Main Menu.

Accessing your voice mail from an outside line
To access your voice mailbox from outside your facility:
1. Dial your company and wait for your system to pick up.
2. During your company’s auto-attendant greeting, dial your voice mail extension number (as assigned by
your system administrator). Or, if your company phone is generally answered by a receptionist, have the
receptionist transfer you to your voice mail box extension.
3. During the playing of your greeting, press the # key on your telephone.
4. Enter your password when prompted. If you make a mistake, you can press # and start re-entering your
password, or press * and return to your greeting.
5. If your password is accepted, you will be placed “in voice mail”, and the system will announce the number of new and old messages in your mailbox, or tell you that there are no new messages. Note that, even
if the announcement says you have no new messages, you can still play any old messages in your mailbox by following the instructions presented above for playing back messages.
6. Use the telephone keypad as described in the diagrams on page 48 and page 50 to play back your messages. Note that if you do not remember the key sequences available, you can wait short time and the system will announce them to you.
Note

If you do not remember your voice mail extension number, you can dial your normal extension number
and wait for it to roll over to voice mail.
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Getting into your voice mail box if your mailbox is full
If your voice mailbox is full and you try to access your voice mailbox from a telephone, you will get a, “This
voice mailbox is full” message. You can still get into your mailbox from your telephone, however, by first
“going under password protection” as follows:
1.
2.
3.
4.

Pick up a phone, or otherwise get an inside line dial tone.
Enter # 3 . The system will ask you for your password.
Enter your password.
If your password is accepted, you will get a voice prompt and another inside line dial tone.

At this point, you are “under password protection” and you can enter your voice mail extension to get into
your mailbox. Once in voice mail, all of your normal voice mail functions will be available, such as 1 for
PLAY, 0 for DELETE CURRENT MESSAGE, etc. Removing some of the messages in your mailbox at
this time will eliminate the “mailbox full” problem.
You can also enter the # , and then your password, during the announcement that the mail box is full.
Alternately, if you are connected to the NexPath Telephony Server over a network, you can use the NexDial
or TelOper program to delete messages from your voice mailbox. You can also use NexDial or TelOper to
copy messages from your voice mailbox to a local computer for storage.

To enter a numeric pager number
You can program any voice mailbox to dial a numeric pager when a new voice mail message is received.
The pager will be sent the caller ID of the person that left the message if you have caller ID enabled from
your telco, and the caller ID is not blocked or unavailable from the call. In the event the caller ID is unavailable, the extension number of the central office line that the call came in on is sent to the pager. In addition,
the voice mail box number and the number of new messages is also sent to the pager.
To announce your numeric pager number do the following:
1. Get into voice mail for your extension, as described above, and assure you are in the main menu by hitting # .
2. Press 7 (the Change Pager Number key) either during or after the announcement of the number of messages in your mailbox, to announce your pager number.
3. Press any key but 0 or * to return to the Main Menu in voice mail.
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To delete your current pager number, do the following:
1. Get into voice mail for your extension, as described above, and assure you are in the main menu by hitting # .
2. Press 7 (the Change Pager Number key) either during or after the announcement of the number of messages in your mailbox.
3. Then enter 0 to delete the current pager number and disable paging.
To enter a new pager number, do the following:
1. Get into voice mail for your extension, as described above, and assure you are in the main menu by hitting # .
2. Press 7 (the Change Pager Number key) either during or after the announcement of the number of messages in your mailbox.
3. Then press * to enter a new pager number, and terminate the entry with a # key.
If your pager number is a long distance (10 digit) number, then you must precede it with a “1”. The system
does not automatically add a “1” to 10 digit numbers.
After pressing 7 (the Change Pager Number key), all digits except 0 or * function as shown in Figure 32 on page 50, to return to the Main Menu in voice mail. After one of these digits is pressed, the digits 0
and * resume their regular functions as show in the Figure.
The NexPath Telephony Server is compatible with numeric pagers that accept the entry immediately after
answering the call. Pagers that have an attendant menu, or require additional PIN numbers to be entered, are
not compatible with the current release of the software.
Note

Additional pager characteristics may be set using TelOper or NexDial.

Recording a short name
You should record a short name for your voice mail box, since this is the announcement that is prepended to
any message that is copied (forwarded) to another voice mail box. Otherwise, the copied message will be
identified as “Extension 501” or the like.
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When you record your short name, it is copied to the file dial_nnn.au (nnn is the extension number, such as
301) in the auto-attendant area, and is used by the Dial By Name auto-attendant to announce your extension
prior to transfer. All extensions that forward to this voice mail box will have the file dial_nnn.au updated by
the new short name recording.
To record a short name, do the following:
1. Get into voice mail for your extension, as described above, and assure you are in the Main Menu by hitting # .
2. Press 6 and begin speaking at the “recording” prompt. You have three seconds to say your name, and
then recording automatically stops.
3. You can play your short name by pressing 5 (make sure you are in the Main Menu as described in #1).

Features Available When Leaving a Message
There are a number of features that are available when a caller is leaving voice mail. You may want to make
the caller aware of these capabilities in your greeting. The “Press 1” function operates differently depending
on whether the greeting is still in progress, or recording has begun. This is described below.

Keys that callers can use during the greeting when they are in voice mail
You may want to let callers know they can press the following buttons while listening to your greeting but
before recording begins:
0

Go to the extension defined as the operator’s extension by your system administrator

1

Opt of out voice mail and go to the extension defined as the voice mail exit extension
by your system administrator (usually the top of the day auto-attendant)

*
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Skip the rest of the greeting and go directly to record

Voice Mail

Keys that callers can use during or after recording a message
After recording begins, callers can press 1 , and they will be prompted with the following choices: .
0

Go to the extension defined as the operator’s extension by your system administrator

1

Replay this message

2

Continue recording

3

Start over and re-record the message

6

Cancel delivery of this message

7

Enter a call back number

#

Opt of out voice mail and go to the extension defined as the voice mail exit extension
by your system administrator (usually the top of the day auto-attendant)

*

Exit voice mail and send the message

The system announces the menu of choices to assist the caller, after they press 1 while in the recording
mode.
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CHAPTER 4

Windows Desktop ToolsNexPath Dialer

NexPath provides a network-based dialer application called NexDialTM for use on Win95/98 and WinNT4
systems with the Release 5 software. NexDial is similar to Microsoft's dialer, but has the features of the
NexPath system, such as hold, transfer, consultation transfer, conferencing, and includes voice mail access.
There is also a Voice Mail indicator and a Do Not Disturb indicator.
The NexDial program interfaces to the NexPath system using the Nexpath API, a LAN-based Simple Computer Telephony Protocol (SCTP) that is more powerful and far easier to use than Microsoft TAPI. NexDial
is the first commercial implementation of SCTP. SCTP is an emerging new standard for client-server computer telephony.
The NexDial program will run on any Win95/98 or WinNT 4.0 system with TCP/IP installed. You must
have TCP/IP installed and configured, and an IP address and/or a system name assigned to the NTS Server,
in order for NexDial to be able to contact the NTS Server. See Connect the system to a network
(optional) on page 18 in the chapter Installation of the System Administration Guide for details on connecting the NexPath Telephony Server to a network.

Installing the NexDial dialer program
1.

Insert the NexPath Telephony Server Release 5 CD-ROM in the Win95/98 or WinNT system from
which you want to run the dialer.
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2.

Note

Click on Start, then Run, then Browse and select the file setup.exe in the Release5\NexPathDialer subdirectory of the CD-ROM. Follow the prompts to install the program on your system.
If you are upgrading a previous version of NexDial, it is not necessary to uninstall the previous version
of NexDial. The Install program will copy your configuration data to the proper place in the Windows
Registry, and label your current configuration Default as described in the steps below. The old version
of the NexDial executable will be overwritten with the new version.

Configuring the dialer

FIGURE 4-1. Configuration Management Screen
1.
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Once installed, start the NexDial program by clicking on Start, then Programs, then NexPath Dialer,
then NexDial.
The NexDial Configuration Management window shown above will only appear if you have more
than one configuration defined. In situations where this is the first installation, there will not be any
configurations defined. In this event, click on Add, and a window will pop up prompting you for a configuration name. Enter a descriptive name, such as “Ext. 301” and click OK. The Configuration window will then appear as show in Figure 4-2. You can then enter the system parameters as described
below.

Windows Desktop Tools- NexPath Dialer

Otherwise, if you have previously installed a version of the Dialer that did not have configuration management, your previous entry will get converted to a configuration named “Default”.
The configuration management screen is used to manage multiple dialer windows on the same client
computer. This will allow you to have several dialer windows running, each logged into a different
extension, or, if necessary, different NexPath Servers.

Optional voice mail
boxes to monitor.

FIGURE 4-2. Configuring setup parameters for NexDialTM
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2.
3.
4.

5.

6.

7.
8.
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To login to the NexPath Server, select the configuration that you want, and then click on Login.
You can always return to the Configuration Management window as follows: At the top of the NexDial
window, click on Tools, then Configure. The NexDial Configuration window will appear.
If you are defining a new configuration, click inside the System Name box, then type in the system
name assigned to your NexPath Telephony Server. If your system name is not available from DNS
(Domain Name Service), or in the \Windows\Hosts file, then you must type in the IP address of the
NexPath Telephony Server instead.
Add your extension number and password to the boxes in this screen. The extension number is the
number of the extension that you are controlling next to your computer. The password is a valid password on the NTS Server. The password must be the password of a user that owns, or has permission to
control, the extension you have typed in the extension box. The owner of an extension has permission
to control it, and any user with administrative privileges has permission to control any extension. If you
enter the password of a user that does not have permission to control this extension, you will get a connection error.
If desired, you can also specify the extension numbers of up to three voice mailboxes that will be monitored. If there is any unread voice mail in any of these voice mail boxes, an indicator will flash indicating new messages. If you do not wish to be notified of any voice mail, these entries may be left empty.
The password you use must have access to voice mail boxes, in order for the voice mail window to
allow access.
Click OK when done.
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9.

If you would like for the dialer to screen-pop upon an off-hook condition, or upon an incoming call, or
display the caller name instead of the caller number (Caller ID), these options can be selected under the
Tools->Options menu.

FIGURE 4-3. The Tools->Options menu in NexDial
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You can also select “Strip Service Codes” and “Strip Carrier Access Codes” to cause NexDial to process the dialed number display (Current Call in the bottom status area). Selecting these options will
delete codes like *82 or *10222 from the number that is displayed, for visual clarity.
You are now ready to use NexDial! To login to the NexPath Server, select the configuration that you want,
and then click on Login.

Features available with NexDial Dialer Window
Screen pops
Whenever a call is ringing your extension, you can configure NexDial to de-iconify (i.e., screen-pop) and
focus to the top of your screen. You can then view the caller ID of the incoming call before you answer it,
and you do not have to search for the application among the various windows you are using. You can also
configure NexDial to screen-pop when you take your telephone off hook as well. This is set under the
Tools->Options menu.
Note

The buttons listed below will be grayed out unless they are appropriate for the current state of your line.
For example, Dial will be grayed out until you take your phone off-hook, and Hold will be grayed out
until you’ve established a call. NexDial is designed to make calls with the telephone in the off- hook
condition. In the current software release, it does not place on-hook calls (the TAPI applications do,
however. See the chapter Installing the NexPath TAPI 2.1 Service Provider starting on page 109
for details on installing TAPI.)
Also, buttons will change names as appropriate to a line’s state. For example, the Dial button will
change to Transfer if you are on a call, since dialing would make no sense while in the middle of a call.

The numeric keypad and the Dial/Transfer button
The numeric keypad within NexDial can be used to enter a phone number. If you have dial tone, then the
button below the Number to Dial box will say Dial, and can be pressed to dial that number.
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If you are on a call, the button below the Number to Dial box will say Transfer, and can be pressed to
transfer your call to the number entered. This is equivalent to the Direct (Blind) Transfer as described in
the chapter Telephone Operations starting on page 41.
The NexDial application should appear similar to the following:

FIGURE 4-4. NexDialTM Network Dialer Application.

65

User’s Guide

User speed dial buttons
Up to seven user speed-dial numbers can be specified for use inside NexDial. Use Edit at the top of the
NexDial window to set up the names and numbers to be associated with each speed dial box. Whenever you
are off-hook and have dial tone, you can click on any speed dial box and that number will be dialed for you.
When you are on a call, clicking one of the speed dial buttons will transfer your call to that number.
Note

User speed dial buttons are not the same thing as system speed dial extensions, setup by the system
administrator.

You can program a speed dial button to pickup a ring group, by entering the group number (a number
between 0 and 9) in the Speed Dial Number box, and clicking on the option box Group to pickup at the bottom of the Edit Speed Dial dialog window.

The function buttons below the keypad
The six buttons below the numeric keypad and the speed dial buttons allow complete call control from the
desktop. These buttons have the following functionality:
Hold

If you are in the middle of a call:
• Pressing this button will push the current call onto the top of the
hold stack. This means that, if no one is in Hold 1, then the current
call will go into Hold 1. If there is already a call in Hold 1, though,
and you press Hold, the call that was in Hold 1 will be pushed down
to Hold 2, and the current call will go in Hold 1.
If you have inside line dial tone:
• This button will retrieve whatever call is currently in Hold 1, pulling
any other calls in the hold stack up one level
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Swap Hold

Swaps your current call with any call in Hold 1.

Disconnect

Disconnects your current call, giving you back an inside line dial tone.
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Set up/Complete Transfer

Will set up a transfer to the number listed in the Number to Dial box.
That is, it will put the current call in hold, and give you back inside dial
tone, allowing you to dial another number. When connected to this new
number, the button will change to Complete Transfer. Click on Complete Transfer to transfer the call currently on hold to the party you
just dialed.
If the party you called doesn’t want the call, disconnect from the new
party using Disconnect, then try another number or use Hold to
retrieve the first caller.

Pick up

If you are in the middle of a call and have call-waiting enabled, you
will hear two beeps if a new call is received while you are off-hook.
Pressing Pick up will place your existing call on hold and pick up the
waiting call. You can then use swap hold to toggle between the two
calls.
Note: information on the incoming call will be displayed on the Incoming Call status line.

Set up/Add to Conference

Pressing the Setup Transfer button puts the current caller on hold and
reserves a conference circuit. After connecting to a second party, pressing Add to Conference brings the first caller back from hold, and puts
all three of you together in a conference call.
You can press Setup Conference again to place both parties on hold,
then call another party and add them into the conference by pressing
Add to Conference again.

Listen/Barge VM

Pressing the Listen VM will allow you to screen your voice mail while
it is in progress. You can listen without the caller’s knowledge, and
determine if you want to take the call. After you press the listen button, the button legend will change to Barge VM. Clicking it when it is
labelled Barge VM will barge into the voice mail in progress, if a
caller is currently leaving a voice mail message. The voice mail box
used is the first voice mail extension that was setup in the Tools->Configure screen.
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Send to VM

Pressing the Send to VM button will send a ringing call, or a waiting
call, to the first voice mail extension that was setup in the Tools->Configure screen.

Call Waiting

You can enable call waiting on your extension by checking the check
box next to this legend. With call waiting enabled, while you are on a
call, if another call comes in it will generate a “beep-beep” sound in the
telephone. The caller ID of the incoming call (if you subscribe to caller
ID from the telephone company) will be displayed on the Incoming
Call status area at the bottom of the NexDial window. You can pickup
the waiting call by clicking the Pickup button, as described above
under Pickup. You can disable call waiting at your extension by clicking on the Call Waiting check box until there is no check mark.

Do Not Disturb

Pressing the Do Not Disturb button will toggle the extension on and
off line, i.e., will toggle the extension from Accept Calls to the Do Not
Disturb mode. When in the Do Not Disturb mode, the red Do Not
Disturb legend will appear in the lower right hand region, and the button will be red. In this mode, all calls will either go directly to voice
mail, or will go to the forwarded extension, or will ring busy. The
extension will also be removed from any call distribution group for
which it has been configured. It will be returned to the call distribution
group, and begin accepting calls, when in the Accept Calls mode (grey
button).

Not Forwarded/ Forward To

To forward the extension to another number, enter the number in the
edit box and click the adjacent button. It should turn red with Forward
To on the button. Click the button again to cancel forwarding.

Voice Mail

The voice mail button, located at the lower left hand corner of the
screen, will turn red if there is unread voice mail in one of the voice
mail boxes setup in the Tools->Configure screen. When button is
clicked, a separate voice mail window will pop-up that allows you to
review and manage your voice mail. See the next section Voice Mail
Access from NexDial for details.
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See Chapter 2, Telephone Operations for further information on using various telephone system call control features.

Status information
Status information for your extension is shown below the ten buttons, including:
Current call

Shows who called whom in the current call. For incoming calls from
outside the building, Caller ID information is displayed if available.

Hold 1

Shows the same information as the Current Call line above, but shows
it for the call placed at the top of the hold stack. This call can be
retrieved by getting inside line dial tone and pressing the Hold button.

Hold 2

Shows the same information as the Current Call line above, but shows
it for the call placed in the middle of the hold stack. Retrieving the call
in Hold 1 and disconnecting from it will move a call from Hold 2 to
Hold 1.

Hold 3

Shows the same information as the Current Call line above, but shows
it for the call placed in the bottom of the hold stack. Retrieving the call
in Hold 1 and disconnecting from it will move a call from Hold 3 to
Hold 2.

Incoming call

Shows either the extension number of an incoming call, or, if the call
originated outside the building, Caller ID information if available. You
can use this information to decide whether or not to take the call

Voice mail

If you have new (unread) voice mail, the VOICE MAIL button will
turn red in the lower left-hand corner of the NexDial window while
there are unread voice mail messages. You can press this button to pop
up a separate window to review your voice mail messages.

Do Not Disturb

The words Do Not Disturb will flash in red whenever your extension
is in the Do Not Disturb mode.
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Voice Mail Access from NexDial
By pressing the Voice Mail button at the lower left hand corner of the NexDial window, you will get a popup window that shows current voice mail and allows you to listen to messages (either on your computer
using multi-media or through the telephone), delete them, copy them to other mailboxes, etc.
The voice mail box that you are accessing is shown in the selector box at the top of the window. If your
password allows you access to other mailboxes, then they can also be viewed by changing the selector box
next to the label Voice Mail Box. Otherwise, you may have access to only one voice mailbox.
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The voice mail access window appears as follows:

FIGURE 4-5. The Voice Mail Window in NexDial
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Playing back a message
To play a voice mail message on your computer, select the Listen with computer radio button at the bottom
of the Voice Mail screen. Then select a message to play by clicking on it. Then click the Play button and
the audio player will pop-up and play the message on your computer’s multimedia system. You must have
an audio card and speakers installed for this function to work.
If you do not have multimedia, or do not wish to listen with your computer, you can click on the Listen with
phone radio button and select a file to play. Lift the telephone receiver of the extension NexDial is logged
into, and click the Play button, You will hear the message being played on the telephone. Note that the
standard voice mail control buttons on the keypad do not work in this mode, and there is no method of start/
stop/skip-ahead when you are playing the message over the telephone using your computer.
You can also play a message by double clicking it, rather than clicking on it and then clicking the Play button.

Calling the call back number
You can dial the caller ID or callback number of the person that left the message, and select whether the call
back should be a 1+, 10 digit, or 7 digit number to dial. For each voice message that is highlighted, the callback number (if the caller left one), or the caller ID, is displayed near the center of the voice mail screen.
You can dial the displayed number by clicking the Dial button next to the number. The extension that you
logged into from the main NexDial window must be off-hook to dial a number from the voice mail window.
You can edit the call back number, if necessary, before clicking on Dial.

Saving a copy of the voice mail file to the local computer
You can save a copy of any voice mail message to you local PC by doing the following:
1.
2.
3.
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Select the message you would like to save by clicking on it.
Select File -> Save on the voice mail dialog box menu bar.
Pick the name and location to save the file using the pop-up file browser.
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Forwarding a message to another voice mail box
You can forward (copy) a message to another mail box by doing the following:
1.

2.
3.
4.
5.

Make sure you have recorded a Copy To Intro as described below (note that NexDial does not use the
short name voice announcement, but instead prepends the Copy To introduction message recorded
using NexDial or TelOper.
Select the message you would like to forward by clicking on it.
Select the voice mail box to which to copy the message, using the selector box by the Copy To button at
the lower portion of the Voice Mail dialog box.
Click on the Copy To button.
Confirm that you wish to forward the message by clicking OK on the pop-up confirmation box.

In the current version of the software, copying a message to another voice mail box with NexDial does not
trigger email notification at the destination voice mailbox.

Recording a Copy To Intro
NexDial does not use the Short Name for prepending voice mail messages copied to to other mail boxes.
Instead, the Copy To Intro is used. To record the Copy To message, which will be prepended to any forwarded voice mail message, do the following:
1.
2.
3.
4.

Lift the telephone extension that NexDial is controlling
Click the Record Copy To Intro button on the NexDial Voice Mail window
Say your Copy To Introduction after the system message “Recording...”
You can hang up or hit any telephone keypad key to stop recording.

Recording your Standard Greeting
The NexPath voice mail system allows two greetings, a standard greeting and an alternate greeting. You can
record your standard greeting from NexDial by doing the following:
1.
2.
3.

Lift the telephone extension that NexDial is controlling
Click the Record Greeting button on the NexDial Voice Mail window
Record your standard greeting after the system announces “Recording...<beep>”
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4.

You can hang up or hit any telephone keypad key to stop recording.

Recording your Alternate Greeting
To record your alternate greeting from NexDial, do the following:
1.
2.
3.
4.

Lift the telephone extension that NexDial is controlling
Click the Record Alt Greeting button on the NexDial Voice Mail window
Record your alternate greeting after the system announces “Recording...<beep>”
You can hang up or hit any telephone keypad key to stop recording.

Selecting the Standard or Alternate Greeting
If the check box next to the legend Use Alt Greeting is checked, then callers will be greeted with your alternate greeting when they enter this voice mail box. If the Use Alt Greeting box is not checked, then they will
be greeted with your standard greeting. You can click on the check box to check and un-check it.

To play back your greetings
In addition to any messages left by callers, the Voice Mail file browser also displays the files Personal
Greeting (your standard greeting), Alternate Personal Greeting, Intro To “Copy To’, and Short Name, if you
have recorded any of these. You can play the greetings back and listen to them in the same way you play
any message. See “Playing back a message” on page 72 above.

Deleting a message or messages
To delete a message, click on it, then click the Delete button, and answer OK to the confirmation box.
You can delete more than one message at a time by highlighting multiple messages in the file display, by
dragging the mouse and optionally using the Shift or Ctrl key in the standard manner of Windows.
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Announce Time and Date and/or Caller ID
You can have the NexPath Telephony Server record the time and date the message was received (the
default), or the Caller ID of the caller, or both at the beginning of the voice mail message. This is done under
Configuration -> Voice Mail Headers. The configuration options appear as follows:

FIGURE 4-6. Voice Mail Message Options
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Numeric Pager Notification
You can use NexDial to configure numeric pager notification of new voice mail. The numeric pager settings
setup screen is accessible from the voice mail window, under Configuration -> Paging Parameters, and
appears as follows:

FIGURE 4-7. Numeric Pager Notification for Voice Mail

76

Windows Desktop Tools- NexPath Dialer

There is an edit box for entering your pager number. It is not necessary to enter a “9” to seize an outside line
(pagers are assumed to be outside numbers), but you must enter a “1” if is it required to dial the number. In
addition to the pager number, you can set the separator character and a pager delay for fine tuning the interface to a paging service. The separator character is sent to visually separate the caller ID of the caller leaving voice mail, from the voice mail box number, and the number of unread messages, to assist in readability.
It defaults to a ‘*’, and is displayed as a ‘-’ on many pocket pagers. You can change this to ‘none’, or ‘#’.
Note

The Nexpath system in the current software release does not support pagers that have a voice menu and
require additional digits to be entered to select numeric paging, or require PIN numbers to be entered.

The pager delay is the number of seconds of delay before sending tone information after connecting to the
pager service. Some pager services are not prepared to accept the touch tones (DTMF tones) as soon as a
connection is made. It may be necessary to use this delay to make the paging work properly.
When you have entered your pager settings, click on Save to stored them on the NexPath Telephony Server.
Numeric paging is disabled when the pager number is saved as a blank entry, which will display as ‘none’.
Note

Pager services are notoriously unreliable, due to both equipment variations on receiving paging
requests, and antenna coverage and blackouts when inside buildings, etc. You may find that
occasionally paging requests are sent by the NexPath Telephony Server, but not successfully delivered
to your pager. Some voice mail systems automatically send three requests, to be sure of delivery. The
NexPath system does not do this at present, but it is under consideration.
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Email Notification
You can use NexDial to configure notification by email when you have new voice mail. The configuration
screen is accessible from the voice mail window under the menu Configure -> Email parameters, and
appears as follows:

FIGURE 4-8. Email Notification for Voice Mail
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Note

The Configure -> Email selection will be grayed out and will not be accessible if email notification has
not been enabled for this voice mailbox. Contact your system administrator to enable email notification
for your voice mailbox if the setup screen is not accessible. Enabling email notification must be done in
AdminTool by an administrator.

Fill in your email address, and the IP address of your mail server. You can use the system name if DNS has
been enabled on the NexPath Telephony Server and you have DNS service. Unless you have the services of
a network expert, who is very familiar with DNS setup and mail hosts, you will have fewer configuration
problems if you use the IP address of your mail host.

Integration with Goldmine 4.0 and ACT! 3 & ACT! 4:
The NexDial program, when running, will contact Goldmine and ACT!, if they are also running, and initiate
a database look-up based on the Caller ID. Goldmine will popup a dialog box informing the user that an
incoming call is available, and indicate if it is found in the database. It allows the user to decide if the contact record should be accessed. ACT! does not pop-up a dialog box, but silently selects the contact record if
the caller ID is found in the database.
Note

Caller ID (number and/or name) must be subscribed to from your telephone company in order for it to
be available to the NexPath system and NexPath software programs. In most locations in North
America, it is not a standard feature but a special service only available as an extra monthly charge.
Contact your local phone company for details.

NexDial must be running (it does not matter if it is iconified or not) for the caller ID look-up interface to
Goldmine or ACT! to be functional.
To dial a call from Goldmine, ACT!, or Outlook, you must install the NexPath TAPI service provider, as
described in the chapter Installing the NexPath TAPI 2.1 Service Provider starting on page 109.
The NexDial caller ID interface to Goldmine and ACT! is provided since the caller ID interface from TAPI
either is non-functional or is not implemented by these programs.
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CHAPTER 5

Windows Desktop ToolsNexPath Call Director

Nexpath provides a network-based operator’s console application called NexDirectorTM for use on Win95/
98 and WinNT systems with the Release 5 software. NexDirector allows a system wide view of the inside
lines, outside lines, voice mail boxes, and park orbits.
The NexDirector program will run on any Win95/98 or WinNT 4.0 system with TCP/IP installed. You
must have TCP/IP installed and configured, and a system name and/or IP address assigned to the NexPath
Telephony Server, in order for NexDirector to be able to contact the NexPath Telephony Server.

System requirements for NexDirector
1.

2.

NexDirector is a large format screen. For best results, use a 17” or larger high resolution monitor with
the video card in the 1280 x 1024 mode. The 1024 x 768 mode is also acceptable if you are using the
small fonts setting. In lower resolution modes, some of the buttons may be off screen.
The Release 5 version of NexDirector supports large and small fonts modes. If you are using large
fonts, you must set your resolution to 1280 x 1024 or the NexDirector display will be too large for the
screen.

81

User’s Guide

Installing the NexDirector operator’s console program
Note

1.
2.
3.
4.

Note
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If you are upgrading a previous version of NexDirector, it is not necessary to uninstall the previous
version before installing the new version. The old executable will be overwritten, and the registry
entries created or copied automatically by the InstallShield program.
Insert the NexPath Telephony Server Release 5 CD-ROM in the Win95/98 or WinNT system from
which you want to run the dialer.
Click on Start, then Run, then Browse and select the file setup.exe in the 1998Release5\NexPathCallDirector subdirectory of the CD-ROM. Follow the prompts to install the program on your system.
Once installed, start the NexDirector program by clicking on Start, then Programs, then NexPath
Call Director, then NexDirector.
A warning may also appear the first time you start NexDirector that it cannot establish a network connection. Click OK again. When NexDirector appears, click on Tools -> Configure, and set up the
login and network parameters. Once you configure NexDirector, you should not get these messages
again unless you have a network problem.
Anytime a new configuration is activated on the NexPath Telephony Server, the network connection
will be terminated and restarted to all clients. This will cause an error box to pop-up on the clients
running NexDirector. Click Okay on this pop-up, and then either kill and restart NexDirector, or
select Tools -> Configure->Okay to re-login to the Server. Otherwise NexDirector will not be
displaying current telephone system activity.
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FIGURE 5-1. NexDirector login screen.

NTS Server Configuration Issues Related to NexDirector
NexDirector will display only the outside extensions or inside extensions that are included in the system
phonebook. Extensions are included or excluded from the system phonebook via AdminTool, by the system administrator. In AdminTool, (administrator only) go to Edit Configuration->Extensions->Edit, and
click on Include in Phonebook. This will cause the extension to show up in the NexDirector display. See
the Figure below. This is described in more detail in Inside Line Extensions on page 37 in the chapter
Software Configuration, and Outside Line Extensions on page 41 in the chapter Software Configuration, in the System Administration Guide.
The NexPath Telephony Server configuration must be saved and activated before the extension will appear
in the NexDirector display, if it was not previously included in the system phonebook. It may also be necessary to re-initialize the button settings by clicking on Tools -> Reset Button Assignment on the menu
bar.
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FIGURE 5-2. Including Extensions in the system phonebook using AdminTool.

84

Windows Desktop Tools- NexPath Call Director

You are now ready to use NexDirector!

FIGURE 5-3. NexDirector Screen

Features available with NexDirector:
1.
2.

NexDirector controls and transfers calls associated with the controlling extension. The controlling
extension is the login extension as shown in Figure 5-1 on page 83.
All call control requires the controlling extension to be off-hook.
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3.
4.
5.
6.
7.
8.
9.
10.

11.
12.
13.
14.
15.

16.
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When a line is connected to a call, the extension button is shown in red, and the connection and caller
ID information is shown below the button.
Outside lines that are disconnected have the button shown in black, and the legend reads “deadline”.
A button color of green indicates the line or park orbit is available.
If you are connected to a call, you can transfer the call to another extension or park orbit by clicking on
the extension, park orbit, or voice mail box button to which you wish to transfer the call.
You can call an extension by clicking on it (the controlling extension must be off-hook and receiving
dial tone).
You can pickup a call that is in a park orbit by clicking the park orbit button.
You can seize a particular outside line by clicking on the outside line extension button (must be green or
unused).
Ringing extensions are shown as blinking white. When a call is ringing, you can capture it to your
extension by clicking on the blinking white button. You must be off hook and receiving dialtone at your
extension to grab a call.
Extensions that are in the Do Not Disturb mode are shown in yellow.
Extensions that are on hold will be red and blinking.
Voice mail boxes that have new (unread) voice mail will be shown in light red.
You can put the current call on hold by clicking the Hold button at the bottom of the screen. To retrieve
the call, click the Hold button again.
To set the logged in extension as Do Not Disturb, click the Do Not Disturb button at the bottom of the
screen. The button will turn red when in the Do Not Disturb mode. To put the extension in the Accept
Calls mode, click the button again.
You can disconnect from the call you are on by clicking the Disconnect button.
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17. The extension buttons can be edited and positioned according to user preferences. To do this, double
click on a button and select from the list. To change the label, type in a new label in the pop-up edit box
that appears when the button is double clicked. See Figure 5-4 below.

FIGURE 5-4. Editing the extension buttons in NexDirector.
If you select an extension that is located on another button, it will be moved to this button. Buttons can
be disabled by selecting the item labelled UNUSED.
You can reset the button settings to the NexPath Telephony Server phonebook settings by selecting
Tools -> Reset Button Assignment, and confirming you want to do this in the popup confirmation
box.
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18. You can setup NexDirector to display the caller number or caller name (you must subscribe to the

FIGURE 5-5. Options for NexDirector
Caller ID service from your local telco). You can also set whether NexDirector will screen pop on
receiving an incoming call or upon taking the receiver off-hook. This is accessed under Tools ->
Options. See Figure 5-5 above.
You can also select “Strip Service Codes” and “Strip Carrier Access Codes” to cause NexDirector to
process the dialed number display (below each button). Selecting these options will delete codes like
*82 or *10222 from the number that is displayed, for visual clarity.
19. You can reset the button labels, if you have made changes to your NexPath Telephony Server configuration, so that they are initialized from the NTS phone book. This is necessary, since once buttons have
been customized, the NexDirector program will not overwrite them even if the NexPath Telephony
Server configuration has changed. By clicking on Tools -> Reset Button Assignment and then Okay,
you can force NexDirector to initialize all button labels to the extension names on the NexPath Telephony Server.
20. Multiple copies of NexDirector can be run and customized (up to 9 instances). Each one retains its
own button settings. This facilitates the use of NexDirector on systems that have more lines than fit on
one screen. The instance number of NexDirector is shown in parenthesis on the heading bar at the top
of the program window.
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CHAPTER 6

TelOper: the Web Browser
Desktop Interface

In addition to the command sequences outlined in previous sections of this manual, and the NexDial and
NexDirector Windows programs, you can control many of the functions of the NexPath Telephony Server
from your desktop computer using your web browser, if your computer meets the following criteria:

• Your computer is connected to the NexPath Telephony Server over a network which supports the TCP/IP
protocol.

• Your computer has Netscape Navigator 3.03 or Netscape Communicator 4.06, or Netscape 4.6 (or later
version) installed.
The desktop web interface program is called TelOper.
Note

TelOper is not compatible with Microsoft Internet Explorer (version 4 or 5) as of Release 5 of the
NexPath Telephony Server software.

Talk to your system administrator about getting your computer to meet these criteria.

To control your phone from your computer
1. Start your Netscape Web Browser program.
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2. Select “Open URL” in your Web Browser.
3. Specify the location to open as http://<system name>1. A Web page similar that below should appear2

FIGURE 6-1. Log-in page for controlling your phone from your computer

1. Replace <system name> with the name assigned your specific NexPath Telephony Server by your system administrator,
or the IP address of the NexPath Telephony Server.
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As described in the log-in page, enter your extension number and password, then click the OK button.
Note

Because of security concerns, if you are running a Web browser at someone else’s computer, you can
still log in to the NexPath Telephony Server using your extension number and password, but you will
not be able to perform any of the telephone-centric functions like dialing a number from the Web
browser since your telephone is physically located elsewhere. You will, however, be able listen to your
voice mail using the computer and copy messages to other users.

Note

There are other URLs that can be used in the system, other than the call control page, some of which are
only available to system administrators. To get a list of these, go to the page at http://<system name>/
help/. (The trailing “/” is required if you are using an IP address). This will list several links that you
can click on to navigate to other web pages in the NexPath Telephony Server. Administration
passwords are required to view some of these links.

2. If this page does not appear, check that you have entered the proper URL and try again. If it still does not appear, consult
your system administrator.
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The Control page
If both the extension number and password you entered are correct, a new window will appear containing a
page similar to that shown below:

FIGURE 6-2. The Control Page
The buttons displayed the Control page can be used in place of or in addition to the command sequences
described previously in this manual. In other words, instead of having to place a call on hold by pressing
Flash * on your telephone keypad, you can simply press the Hold button in this page while you are connected to a caller and the call will be put on hold. These functions will only apply, though, to the telephone
associated with your extension number, so your phone will have to be off-hook and connected to a call
before the Hold button will do anything.
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Selecting a voice mail box to monitor
Your user name will be shown in the upper left corner of this page, along with your extension number.
Below them is a pull-down list labelled Monitor VMB containing all voice mail mailboxes to which you
have access. There is an additional entry at the bottom labelled USER. The USER selection represents all
voice mail boxes that you own, and will activate monitoring of all of those mail boxes. For most people, this
will be a list with only two entries, the user’s voice mail box and the USER entry, and both represent the
same thing. The voice mail mailbox selected from this pull-down list will be the one used by the voice mail,
VM Barge-in, Send to VM, and Password buttons on this page. If you own more than one voice mail box,
and you select USER, then the mail box selected by these functions will be the first one that you own in the
list. You can tell which voice mail boxes are being monitored by looking at the information in the status
frame in the lower left hand corner of the main screen.

VM Barge-in
If you miss picking up your phone before a call rolls over to voice mail, you can still connect to the caller
while he or she is leaving you a message by clicking this button. Your phone must be off-hook for this button to have any effect, though.
The Listen feature is not implemented at this time in TelOper.

Send to VM
If your telephone is ringing, and you do not wish to take the call right now, you can send it directly to voice
mail by clicking on Send to VM (Send to Voice Mail) while it is ringing. It will immediately be transferred
to your voice mail box instead of ringing until it rolls over to voice mail.

Hold
While you are on a call, you can click on the Hold button to put the caller on hold. Click again on the Hold
button to bring the call back, or Swap Hold to simultaneously put a current conversation on hold and
retrieve the call on hold.
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Note

You can put up to three calls on hold simultaneously, but to retrieve them, you will have to take them
off hold in the last-in/first-out order. The hold system works like a stack of boxes, and so is called a
hold stack. The last call put on the top of the hold stack is the first one that you get when you take a call
off of hold.

Call Control
In the upper right of the Control page is a pull-down list labelled Name which contains a list of all extensions available in your system. Below it is a fill-in box labelled Number. The buttons in the Call Control
area (Dial Number, Blind Transfer, etc.) will use the number in the Number box as the phone number to
dial, transfer to, etc. The pull-down Name list, in turn, can be used as a convenient way of filling the Number box.
Once you have filled in Number, you can click on the Dial button to dial it (or click Enter on your keyboard). When your party picks up, Dial will turn to Disconnect, allowing you to hang up without releasing
the line, the same as if you used the Disconnect sequence Flash # (see Disconnecting on page 22 in the
chapter Telephone Operations for details).
Note

You can use the PhoneBook button in the Call Control area to both add numbers to the pull-down
Name list and to add speed-dial buttons to the browser frame area to the right of the Call Control area.

Other buttons on this page include:

• Blind Transfer. Select the extension from the Name list, then click this button to transfer a call to that
extension.
• Set up Consul. Transfer. To set up a transfer with consultation, click Set up Consul. Transfer. This
will put your current call on hold and give you inside dial tone. Dial the party to whom the call is to be
transferred using either your telephone keypad or the Name list, Number box, and Dial button in this
page. Once connected, the Set up Consul. Transfer button will change to Complete Transfer. You can
click on Complete Transfer to complete the transfer, or From Hold to get the caller back if the party did
not answer or does not want the call.
• Set up Conference. To set up a conference, call your first party and tell them you are going to put them
on hold while contacting the next party, then click on Set up Conference. Your party will be put on hold,
and you will get an inside dial tone.
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Dial the next party to be added to the call, using either your telephone keypad or the Name list, Number
box, and Dial button in this page. Once connected, this button will change to Add to Conference. Click
on Add to Conference to bring your original caller into this new call. The button on this page will
change back to Set up Conference.
To add a fourth party to the call, click on Set up Conference again, then dial the fourth party and click
on Add to Conference after the call is established.
• Call Waiting. If you have call waiting enabled for your extension and you hear a “beep-beep” tone while
in the middle of a conversation, you can use this button to pick up the incoming call and place your current caller on hold. You can then use the Swap Hold button to transfer between the two.
• Call Barge-in. If you have barge-in privileges, you can select an extension from the Name list, then click
on this button to barge into an existing call on that extension.

Using the Ring Group button
This button can be used as an alternative to entering the Pick Up Ring Group command sequence * 0 from
your telephone. See Pick up on page 40 in the chapter Telephone Operations for details on ring groups.
Clicking on the Ring Group button brings up a page similar to the following:

FIGURE 6-3. A Ring Group page
To use this page, pick up your phone, select the pickup group you want to pick up from the pull-down list,
then click on the Pick Up Group button.
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The voice mail page
When you receive new voice mail, a Voice Mail Alert box similar to that below will appear on your screen,
and the word “VoiceMail” in the voice mail button in the Control page will also turn red. The alert will

FIGURE 6-4. A voice mail alert box
indicate the number of new and old messages, and the voice mail box to which the new message arrived.
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Clicking on the voice mail button in the Control page brings up a window similar to the following:

FIGURE 6-5. A sample voice mail page
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Your user name is listed at the top of this window. Below it is a pull-down list of all voice mailboxes to
which you have access. For most people, this will be a list with only one entry, so clicking on it will not
actually bring up any more entries.

Setting message, pager, and email parameters
At the bottom of the Voice Mail page, you can set whether you want a voice announced time and date at the
beginning of each voice mail message, or if you want the caller ID announced at the beginning of each message, or both. See Figure 6-5 above. Select Announce Time of Day (on or off) and Announce Caller ID (on
or off). Then click on Change Voice Mail Settings to submit it to the NexPath Telephony Server. A confirmation box will appear to ask if you are sure, and the voice mail window will refresh if the submit was successful. Note that the voice announcements are recorded as part of the message, so the settings only take
affect on future voice mail messages.
Similarly, your numeric pager settings can be changed. In addition to the pager number, you can set the separator character and a pager delay for fine tuning the interface to a paging service. The separator character
defaults to a ‘*’, and is displayed as a ‘-’ on most pocket pagers. This assists in readability, to separate the
caller ID from the voice mail box number, and the number of unread messages currently in the mail box.
You can change this to ‘none’, or ‘#’.
Note

The Nexpath system in the current software release does not support pagers that have a voice menu and
require additional digits to be entered to select numeric paging, or require PIN numbers to be entered.

The pager delay is the number of seconds of delay before sending tone information after connecting to the
pager service. Some pager services are not prepared to accept the touch tones (DTMF tones) as soon as a
connection is made. It may be necessary to use this delay to make the paging work properly.
When the pager entry is blank or ‘none’, numeric paging is disabled.
Note

98

Pager services are notoriously unreliable, due to both equipment variations on receiving paging
requests, and antenna coverage and blackouts when inside buildings, etc. You may find that
occasionally paging requests are sent by the NexPath Telephony Server, but not successfully delivered
to your pager. Some voice mail systems automatically send three requests, to be sure of delivery. The
NexPath system does not do this at present, but it is under consideration.
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You can use TelOper to configure notification by email when you have new voice mail. The parameters are
entered at the bottom of the Voice Mail window.
Note

The Email settings will not be accessible if email notification has not been enabled for this mail box.
Contact your system administrator to enable email notification for your voice mail box if the setup
parameters are not accessible. Enabling email notification must be done in AdminTool by an
administrator.

Fill in your email address, and the IP address of your mail server. You can use the system name if DNS has
been enabled on the NexPath Telephony Server and you have DNS service. Unless you have the services of
a network expert, who is very familiar with DNS setup and mail hosts, you will have fewer configuration
problems if you use the IP address.

Dialing Method for Call Back
You can select the method for dialing the person that left you a voice mail message. First, click on the message that has the caller ID you wish to re-dial, then click on the radio button for the method of dialing you
wish to use. This may be 1+ dialing, where a ‘1’ will be prefixed to the 10 digit number, or 10-digit dialing,
where the 10 digits will be dialed without a ‘1’, or 7 digit dialing, where the area code will be removed and
just the last seven digits dialed. Then lift your telephone from the receiver and click on Dial. See Figure 65 above. This setting has no effect when dialing inside extensions.

Other Voice Mail Features
Below the voice mailbox list is a window which lists your voice mail greeting (if you’ve recorded one), the
introductory message to be used with the “Copy Message to” command (explained in more detail below) if
you’ve recorded one, and all voice mail messages currently in the selected mailbox. Each message in the
mailbox is identified by the time and date it was recorded, along with its length, and the telephone number of
the caller (Caller ID) if available. New messages are identified with a § prefix. Message are listed in reverse
chronological order (i.e., newest messages are listed first).
To play back either a message, your greeting, or the “copy to” introductory message, use your mouse to
highlight an item in the listing window, then click the Play button. See below for details on selecting
whether the message will be played over your computer’s speakers or through a telephone.
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You can delete an item from this window by selecting it and then clicking on Delete. Only one message can
be deleted at a time.
To copy the audio file associated with an item in this window to a local drive, press Save Local. You may
want to save important voice mail messages on your local computer because you will eventually run out of
room in your voice mailbox on the system1.
To review your voice mail greeting, click on the message entitled “Personal greeting” in the message window and then click the Play button. You can re-record your greeting by clicking on the Record Greeting
button and following the prompts.
You can copy a voice mail message from your mailbox to someone else’s. To copy a message, record an
introductory message using the Record Copy to: Intro button (if you have not already done so), then select
the message you want to copy, use the pull-down list at the bottom of the screen to select the mailbox to
which you want to send the message, then press the Copy Message To: button. Your “copy to” intro message will automatically be added to the beginning of all copied messages, so you should record something
like, “This message was forwarded from <your name>’s mailbox.” You can record and re-record your “copy
to” intro message as many times as you want, so theoretically it can be tailored for each user as each message is sent.
In the current version of the software, copying a voice mail message to another mail box using TelOper will
not trigger email notification for the destination mail box.
Note

When recording your Copy to: Intro or your Greeting, you can terminate the recording by hitting any
key on the keypad, or by simply hanging up.

The check-boxes at the bottom of this screen allow you to select whether to playback of messages is performed through your computer or through your telephone. Playback through your computer uses the
browser’s built-in audio playback capabilities, so this will only work if your computer and browser are
already able to play audio files.
Alternately, you can play messages over a telephone by clicking the Listen with telephone check-box. The
telephone used will be the one associated with the extension you logged in with.

1. The amount of time you are allowed for messages in your mailbox is set by your system administrator.

100

TelOper: the Web Browser Desktop Interface

Normally, the NexPath Telephony Server updates this screen as soon as a new message is completed. If you
think you have a new voice mail message, but it does not appear in the list of messages, click the Reload
button at the bottom of the screen to update the screen contents. Alternately, you can close this window by
clicking on the Close Window button at the bottom of the screen.

System Information
The button labelled with a key in the Control page is the System Information button. Clicking on it brings
up a window similar to the following:

FIGURE 6-6. The System Information page

101

User’s Guide

You can use this window to change your password. Additionally, if your account has been set up with permission to change the system from Day mode to Night mode and vice-versa, you can use the checkboxes in
the center of this page to change the system mode. See Day Ringing/Night Ringing on page 20 in the chapter
Telephone Operations for details on these modes.
If you have system administrative privileges, you can also click on Show System Configuration and get
detailed information on the system’s current configuration, though you will not be able to make any changes
to the system configuration from the window displayed. See the NexPath Telephony Server System Administration Guide for more details.
You can use the System Information Page to save your current settings. Click on the button Save Current
Settings and your settings will be saved. The server will pop up a confirmation box if the operation was successful.
The following settings are currently saved to the server when the Save Current Settings button is clicked:

• Main Page: Monitor VMB selector box, Name selector box.
• Voice mail page: Voice mail box selector, Listen message radio button, Copy Message To selector box.
• Phonebook page: Name/number selector box.
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Using the Phone Book page
When you click on the Phone Book button, a page similar to that shown below will appear:

FIGURE 6-7. A sample Phone Book page
This pull-down list at the top of this page can be used to select a phone number from either the system-wide
phone book (which you cannot alter), or your personal phonebook (which you can alter).
The system-wide phone book is handy in that you can select an entry from the list, then either dial that number by pressing Dial button or use the entry as the starting point for creating a new entry of your own.
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To create an entry in your personal phonebook, fill in at least the Name and Number entry forms and then
click on Add/Update1. Your entry will be added to your pull-down list. Note that you can enter values in the
Number field either from your keyboard or by clicking on the numbers displayed on the picture of a touchtone keypad. Everything but numbers, commas, and the # and * characters will be ignored. The dialer will
convert each comma in an entry into a 1 second delay.
Also, entries which start with a 9 will cause an outside line to be seized, then all numbers after the 9 to be
dialed. To add an entry for 911, for example, you will want to set the number to be dialed to 9,911. The
comma between the nines gives the system time to seize the outside line.
Finally, any entry with seven or more digits will be assumed to be for an outside number, and the system will
automatically seize an outside line before dialing. No prefix of 9 is needed in this case, and if one is added, it
will be removed before the number is dialed. Only the first grouping before the first comma is analyzed to
determine if it is an inside or outside call.
For example, to seize the outside line that is associated with extension 203, then dial 555-1234, then wait
four seconds and enter #111, type the following: 203,555-1212,,,,#111. This will work the same
way whether it is in the phonebook, or typed in the Number entry box on the Control page.
To edit an entry in your personal phonebook, select it from the pull-down list, then make your changes and
click on Add/Update again.
Note

Entries in the phonebook are arranged by name, so each name must be unique. For example, If you
change the name of the entry for Steve to Steve Sampson, then click on Add/Update, you will have two
entries, one for Steve and one for Steve Sampson. You can remove the extra entry by selecting it from
the pull-down list, then clicking on Delete Entry.

You will receive an error message if you attempt to modify or delete entries from the system-wide phonebook.
By specifying a Speed number to be associated with an entry, you will create a speed-dial button back on
your Control page. The number you enter in the Speed # box determines the order in the list of buttons that

1. If you use an entry from the system-wide list as a starting point, you will need to change at least the Name
field before you will be able to save any modifications.
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the entry will be located. A one places the speed button at the top, larger numbers place it towards the bottom. To remove a speed-dial button from your Control page, select the entry associated with the speed-dial
button as it appears in the phonebook, remove the speed dial number from it, then click on Add/Update.
It is possible that, over time, you may generate a long list of entries in your personal phonebook. If so, you
can make a copy of your personal phonebook to your computer by clicking on Save PB Local.
By applying a normal text editor to the file you saved, you can see that the personal phonebook file is a pipeseparated list, where “|” is the pipe character. You can edit or otherwise revise your personal phonebook file
(perhaps by dumping the contents of an existing contact manager program such as Act! into the file), and
then copy the modified phonebook file back to the NexPath Telephony Server computer by using the
Upload PB button. The File Name fill-in form and the Browse button can be used to select the personal
phonebook file to be uploaded.

The View Log button
Another NexPath Telephony Server feature you can access only from a Web page is a review of all calls
made to and from your phone, including the time and date of each call, either the number you dialed or who
the call was from, and the duration of each call.
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To bring up this information, click on View Log in the Control page. This will bring up a Web page with a
format similar to the following sample page:

FIGURE 6-8. A sample Call Log page
The call log feature uses three 1 Mbyte files in a round-robin fashion. When CallLogA gets full, the program
starts filling CallLogB. When that gets full, information goes in CallLogC. When that gets full, CallLogA is
wiped out and restarted. You can use the pull-down list in the upper left corner of this window to select
between the logs available. The system automatically selects the latest call log when you open the screen.
The filters can be used to reduce the amount of information shown in the call log. When these fields are
blank, all calls in the currently-selected call log are displayed. By entering either whole phone numbers or
substrings of numbers, you can reduce the display to just the information in which you are interested. For
example, to show only calls made from 752 to anywhere, set the filters to
From filter: 752
To filter: (blank)
then click on the Reload Log button.
To enter more than one telephone number or substring in a field, separate the numbers with the “pipe” character “|”. For example, to show all calls made from extension 743 to either extension 120 or 152, type in
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From filter: 743
To filter: 120 | 152
then click on the Reload Log button.
By default, the filters used on the call log are ANDed; that is, only entries which contain the information
specified by both the filters simultaneously are shown. You can OR the two filters together, however, by
adding the word “OR” anywhere in your “To filter” entry. For example, to list all calls made either to or
from extension 743, type in
From filter: 743
To filter: OR 743
then click on the Reload Log button.
The From Date and To Date set the inclusive range of dates from which the log records are selected. Dates
can be ‘Dec 4’ or ‘Jan 5’, or in the form ‘12/29’ or ‘11/30’. The keyword today is recognized as the current
day as determined by the NexPath Telephony Server.
A single entry such as ‘Dec’ or ‘12’ is assumed to be ‘12/1’ or ‘Dec 1’ in the From Date field, and ‘Dec 31’
or ‘12/31’ in the To Date field. If the entire From Date field is left blank, then it is interpreted as the beginning of the file. If the To Date field is left blank, it defaults to today.
Unless you log in as the system administrator, you can only view calls made to and from your normal (primary) extension number.
You can copy the information currently being viewed from your call log to a local computer by clicking on
Save Local Copy. A pipe-separated text file (“|” is the pipe character) will be saved which can then be
imported directly into Microsoft Excel or Microsoft Word. The field format can be determined with a
header row which is written as the first line in the file.
The Close Window button allows you to exit the View Log window altogether.
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The status information at the bottom of the Control page
At the bottom of the Control page are three columns of check-boxes and four status indicators showing your
extension’s current status.
The check-boxes in the leftmost column can be used to set your extension to the Accepting Calls mode or
the Do Not Disturb mode. See Accept Calls/Do Not Disturb on page 10 in the chapter Telephone Operations
for details on these two modes of operation.
The check-boxes in the middle column can be used to enable or disable call-waiting for your extension. See
Call Waiting on page 16 in the chapter Telephone Operations for details on call-waiting.
The rightmost column of check-boxes at the bottom of the control page can be used to enable or disable callforwarding. The text box next to check-box labelled Forward calls to allows you to enter a number (either
an extension or offsite number) to which to forward calls. If the number is seven digits or more, an outside
line is seized. Long distance numbers must be preceeded by a ‘1’.
Note

You can only select one of the two check-boxes in any one column at a time.

Along the bottom of the page are four status indicators: Call on Hold, Conference, Cons. Transfer, and
Voice Mail.
When you have a call on hold, the Call on Hold indicator will turn red and blink. Note that you can use the
From Hold button to retrieve the call.
The Conference indicator will turn blue and blink when you initialize a conference circuit, and will remain
blue until you leave the conference.
The Cons. Transfer indicator will turn green and blink when you initialize a transfer with consultation, and
will remain green until the call is successfully transferred or returned to you.
Finally, the Voice Mail button will turn red and blink when you have unread voice mail in your voice mailbox.
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Installing the NexPath TAPI 2.1
Service Provider

NexPath provides a TAPI service provider for installation on WinNT4 and Windows 95/98 systems, as a
general dialing interface to Windows programs written to the TAPI standard. Examples of compatible programs are the Microsoft Dialer, Outlook, ACT!, and Goldmine.

Installing the NexPath TAPI 2.1 Telephony Service Provider (TSP) program
Before installing the NexPath TSP, make sure that your network in operational and that you can contact the
NexPath Telephony Server from your Windows PC via TCP/IP using the ping program or other method.
See Connect the system to a network (optional) on page 18 in the chapter Installation of the System
Administrators Manual, or contact your system administrator for details on establishing a network connection to the NexPath Telephony Server.
1.

2.
3.

If you have a previous version of NexPath TAPI installed, uninstall it first. See “Uninstalling the NexPath TAPI Telephony Service Provider (TSP)” on page 115 for directions on uninstalling a previous
version of the NexPath TSP.
Insert the NexPath Telephony Server Release 5 CD-ROM in the Win95/98 or WinNT4 system from
which you want to run the TAPI compatible programs.
If you are using Windows 95, first install Microsoft TAPI 2.1 by clicking on Start, then Run, then
Browse and select the file Tapi2195.exe in the Release5\NexpathTapi21\Win95_ONLY subdirectory.

109

User’s Guide

Note

4.

5.
6.
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WARNING: Do not run the Tapi2195.exe program on any system but Windows 95. Running this
program on NT (or Win98) will overwrite the Microsoft TAPI program with a version that will not
work.
Then install the NexPath TSP as follows. Click on Start, then Run, then Browse and select the file
setup.exe in the Release5\NexpathTapi21 subdirectory of the Release 5 CD-ROM. Follow the prompts
to install the program on your system.
After the NexPath TSP is installed, you need to add it to the recognized service providers. Click on
Start, then Settings, then Control Panel to bring up the Control Panel file viewer.
Locate the Telephony icon in the control panel and click on it, then select File -> Open to bring up the
Dialing Properties dialog box.

Installing the NexPath TAPI 2.1 Service Provider

7.

Click on the Telephony Drivers tab, and the NexPath TSP32 should be visible as below:

FIGURE 7-1. Telephony Dialing Properties Window
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8.

Click on NexPath TSP32 to highlight it, then click on Configure. The NexPath Configuration window
should appear as shown below:.

FIGURE 7-2. The NexPath TAPI 2.1 Configuration Window
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9.

Fill in your system name (or IP address). (If you are using a system name, it must be in the hosts file or
published in DNS for it to work. See Using your System Name rather than the IP Address on
page 20 in the chapter Installation or the System Administration Manual for details. Then click on
Add Line, click on the text area Line Name, and type in a descriptive text name, such as Ext. 301, for
your line (delete the NewLine text unless you want this to be your line name).

Note

Take care to enter the information correctly in the NexPath configuration window. Errors (such as
invalid extensions or passwords) can cause the MS TAPI Server to repeatedly crash, making it very
difficult to recover.

Note

The NexPath TSP can only be configured to connect to a single NexPath Telephony Server. However,
it can be configured to support multiple extensions on a given NexPath system.

10. Then click on Add Ext, and click in the text area Extension Properties, delete the 0, and type in your
extension number, such as 301.
11. Click on the Password text box, and type in a valid NexPath system password, such as the default for
mailbox 501: 1001.
12. Click on the checkbox for ACT! if you are using ACT!.
13. Carefully check your settings and click on OK at the top and then Close to close the Dialing Properties
window.
14. If any settings are incorrect, or there is a problem with the network, there may be a long delay (60 seconds or more), and you will get a network or NexPath TSP error. The NexPath TSP contacts the NexPath Telephony Server via the LAN, so the LAN-TCP/IP interface must be functional for the TSP to
function.
15. Installation is now complete. You are now ready to use Microsoft TAPI programs for dialing numbers.

Using the NexPath Telephony Service Provider (TSP) with other programs
Programs such as the Microsoft Dialer (Programs -> Accessories -> Phone Dialer on Win95 and NT),
Outlook, Goldmine, and ACT! are TAPI compliant, so they allow calls to be dialed using these applications
with the NexPath TSP installed. You should consult the documentation for these programs on how to select
the address and line to work with the NexPath Telephony Server.
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For example, when you are running the Microsoft Phone Dialer, click on Tools -> Connect Using... to
bring up the Connect Using dialog box. Select the line and extension in the Line and Address selector
boxes, respectively, that you configured above in the installation process, to configure the MS Phone Dialer
to dial using the NexPath system. The display should appear as below:

FIGURE 7-3. Configuring the Microsoft Phone Dialer to use the NexPath Telephony Server TAPI
interface.
Note that numbers are dialed with the telephone ON HOOK, for TAPI calls. This is different than calls
placed with NexDial, which are done off hook. The telephone extension that you configured for TAPI will
ring when the call is placed.
For outside calls, the call that is placed will roll over to voice mail (if voice mail is configured for this extension) if the calling extension is not picked-up within the time-out time (usually 20 seconds).
For inside calls, the call will be disconnected if the calling extension is not picked-up within 10 seconds.
Note
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The Microsoft TAPI interface only supports ON HOOK dialing. It will not dial the telephone with the
extension off hook.

Installing the NexPath TAPI 2.1 Service Provider

Uninstalling the NexPath TAPI Telephony Service Provider (TSP)
To uninstall any version of the NexPath TSP, do the following:
1.
2.
3.
4.
5.
6.

7.
8.

Click on Start -> Settings -> Control Panel to bring up the Control Panel file viewer.
Click on Add/Remove Programs, then Select File -> Open (or double click) to bring up the Add/
Remove Program Properties window.
Click on the Install/Uninstall tab, then locate NexPath TSP32 in the browser window, and click on
Add/Remove. Follow the prompts to remove the NexPath TSP32 program.
Next, remove the NexPath TSP from the service providers by opening the Telephony icon in the Control Panel as described in Item 5-6 in the installation procedure above.
Click on NexPath TSP32 and then click on the Remove button. Click Yes at the prompt to remove it
from the recognized service providers.
Next, using the Windows File Explorer, locate the Windows\System subdirectory, and delete the file
NexPathxx.tsp, where xx may or may not be present, or may be numbers such as 16 or 32. On Windows
NT4, this file is located in the directory WinNT\System32\.
Reboot your PC.
The NexPath TSP is now completely removed.
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CHAPTER 8

Question:

How do I put a caller on hold?

Answer:

During your conversation, enter the Put Call on Hold sequence Flash 1 . The caller will be
put on hold, and you will get an inside dial tone. You can hang up, call another party, whatever...
To retrieve the call from hold, pick up your phone or otherwise get an inside dial tone, then use
the Retrieve Call from Hold sequence * 1 .

Question:

How do I transfer a call?

Answer:

You can:
•

Do a blind transfer using Flash 4 , then enter the extension number to which you wish to
transfer the call.

•

Do a transfer with consultation by entering the Set Up Transfer sequence Flash 5 , which
will put your caller on hold and give you an inside dial tone. At this point, dial the party you
plan on transferring the call to and tell them that a call is coming, then complete the transfer
using the Complete Transfer sequence Flash 6 . Note that if you can’t reach the second
party, or they don’t want the call, you can retrieve the original caller by getting an inside
line dial tone and using the Retrieve from Hold sequence * 1 .
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•

You can put the caller in a park orbit using a the Blind Transfer sequence Flash 4 , then
transferring them to a park orbit (100, for example). You can then page the person you want
to have pick up the call by dialing the Paging extension 111 and announcing that so-and-so
has a call on 100. The other person just has to pick up any phone and dial 100 to pick up the
caller from the park orbit.

Question:

Sometimes I’m in another person’s office when I hear my phone ring. How can I avoid
having to run to my office to catch the call?

Answer:

Pick up the phone closest to you and enter the Pick Up Ring Group 0 sequence * 0 0 .

Question:

Late at night, I sometimes hear the phone ringing over our PA system. What is this, and
how to I pick up the call?

Answer:

When your system is set to “night ringing”, incoming calls may be set to ring over the PA system so that anyone left in the building will hear it and be given the chance to answer. To pick
up these calls, enter the Pick Up Ring Group 1 sequence * 0 1 .

Question:

My phone occasionally rings with a short ring, but when I pick it up, no one is there.

Answer:

You have a call waiting on hold or stuck in a park orbit. You can retrieve it by getting an inside
dialtone at the phone which is giving the short rings and using the Retrieve From Hold
sequence * 1 , or dialing the park orbit number, such as 100.

Question:

I put a caller on hold, then started another conversation and accidentally put the second
caller on hold also. How do I get back to the first caller?

Answer:

You have to pick up your second caller from hold using * 1 , then either use the Swap Hold
sequence Flash * to put the second caller on hold and retrieve the first caller, or finish your
call with the second caller, hang up (or disconnect using Flash # ), then pick up and retrieve
the first call from hold using * 1 .
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Question:

When people call my extension, my phone doesn’t ring. Instead, their calls go to my voice
mail. When I call them back, they say they heard my phone ring, but I didn’t pick up.
What’s going on?

Answer:

If your phone is equipped with a switch to turn the ringer on and off, check it and make sure
that the ringer is turned on.
If the ringer is on but the phone still won’t ring, you may have your extension in the Do Not
Disturb mode. Change the mode to Accept Calls as described on page 10.

Question:

Sometimes, when I’m in the middle of a conversation, I hear two beeps. What does this
mean?

Answer:

This is the call-waiting indicator, meaning that another caller is calling. You can put your existing call on hold and pick up the new call, or let the new call go to voice mail.
By the way, one beep would be a reminder that you have another call on hold, and three beeps
would indicate that someone else has barged into your conversation by using the Barge In
sequence # 2 .

Question:

When I pick up my phone, I hear a beep-beep-beep tone then a steady dial tone. What
does this mean?

Answer:

This is known as a stutter dial tone. It indicates that you have new messages in your voice
mailbox You can have more than one voice mail box causing a stutter dial tone on you extension. See the next question for details.

Question:

When I pick up my phone, I get a beep-beep-beep tone instead of a steady dial tone, but
when I access my voice mailbox, there are no new messages.

Answer:

The phone you are picking up may have more than one extension associated with it, and the
new message or messages indicated by the stutter dial tone may be for one of these other extensions. Use the Announce Line and Extension Numbers sequence # 8 to determine the physical line number and all extension numbers associated with the telephone being used, then try
accessing the voice mailboxes of any other extensions mentioned. For example, in the default
configuration, Ext. 303 has both mailboxes 503 and 599 that cause stutter dial tones on its line.
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Question:

Do I have to be at my computer to use the computer interface programs?

Answer:

For dialing functions, you have to be able to lift the receiver. But you can control any phone if
you have proper permissions. You can access the Web browser page, or NexDial or NexDirector, from any computer on your network, but will still need to log in using your usual
extension number and password. Also, unless you have system administration privileges, none
of the operations that require a phone, such as listening to your voice mail over the phone or
using your speed-dialer to dial a number, will be accessible from any other phone but the one
on your desk.

Question:

What do I do when I can’t dial “out” from the Web browser?

Answer:

First, make sure you have a 9 at the beginning of your number, then a 1 before the area code if
one is present. If these are both present, then it’s possible that your problem is that you are not
successfully seizing an outside line.
The 9 at the beginning of your number causes the NexPath Telephony Server to seize an outside line, wait one second, the dial the remaining digits. If the system is running slow (perhaps
a lot of people are making conference calls), then it may take more than one second to seize an
outside line. Try adding one or two commas after the 9 at the beginning of the number (each
comma creates an additional one second delay).

Question:

I cannot get my web browser to properly log into the NexPath Telephony Server. What
could be wrong?

Answer:

First, make sure you are using Netscape 3.03 or later or Communicator 4.04 or later browser
version. If you do not have DNS, you must enter the system name in the Windows HOSTS file
(see next paragraph, or your system administrator), or you must use the IP address instead.
JavaScript and cookies must be enabled in the browser. To be sure you have a good network
connection, try pinging the NexPath Telephony Server. This can be done from a DOS window, by typing the command ping followed by the system name or IP address. You should
get a response. If you do not, either TCP/IP is not installed correctly, or the network cable is
not properly connected. Remember that the NexPath Telephony Server only uses the 10BaseT
network connector (RJ-45 phone jack style connector).
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The HOSTS file on Windows 95 is located at \Windows\Hosts. On Windows NT, it is located
at Winnt\system32\drivers\etc\Hosts. Make sure you are not trying to use the HOSTS.SAM
file, or LMHOSTS. These will not work. The HOSTS file should contain at least two lines:
127.0.0.1

localhost

111.111.111.111

nexpath

Substitute your IP address for 111.111.111.111 and your NexPath system name for nexpath.
Also see Testing your network connection on page 20 in the chapter Installation of the
System Administration Guide.
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APPENDIX A

Accept Calls mode

Glossary

Individual extensions can be placed in either an “Accept Calls” mode or a “Do
Not Disturb” mode. The “Accept Calls” mode is the normal mode of operation.
In comparison, when an extension is in “Do Not Disturb” mode, calls placed to it
will not ring the phone associated with the extension but instead will be sent
directly to voice mail.
If the extension is part of a call distribution group, incoming calls will be routed
past any extensions which are in the “Do Not Disturb” mode and will go on to
the next extension in the group.

ACD

Automated Call Distribution or Automatic Call Distribution. See call distribution groups below.

auto-attendant

An automated call-routing system for incoming calls which can be used either
instead of or in addition to a live operator. The auto-attendant is the system which
tells incoming callers, “Press 1 for Sales, 2 for...”

barge-in

Breaking into an existing conversation or picking up a line after a caller has
already started leaving voice mail
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call distribution group

Groups of extensions can be grouped into a call distribution group. This function
is part of the auto-attendant function, and is normally used to allow callers to dial
an entire department, such as sales, rather than just an individual. When the autoattendant routes a call to a call distribution group, the phones associated with all
extensions set to “Accept Calls” in the group will ring in sequence (one at a time)
until either the call is picked up by someone or it times-out. If a call times-out,
depending on how the auto-attendant is configured, the call is either sent to voice
mail or the caller is given a message and disconnected. If at least one of the
extensions in the group is busy, then the call will go into a waiting queue, where
reassurance messages are played, along with hold music if enabled, until either a
time-out is reached or one of the group extensions becomes available.
Note that call distribution groups are not the same as ring groups. See ring
groups for the definition of a ring group.

call forwarding

When call forwarding is enabled for an extension, callers dial one extension (for
example, 752) but the call rings and can be answered at another extension (for
example 805). The extension dialed (752) is the “forwarded” extension. The
extension where the call actually rings (805) is the “forwarding” extension. Note
that, in this example, if no one answers at the phone at extension 805, the call
will go to the voice mailbox of extension 752.

call waiting

When call waiting is enabled for your extension, you will hear a short beep at
your end of the conversation if you are on the phone and another call comes in.
Note that, when you hear a call-waiting beep, you can simultaneously place your
current call on hold and pick up the incoming call by entering the Pick Up Waiting Call sequence Flash 3 .
You can then toggle between the calls using the Swap Hold sequence

Flash * .
Centrex
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Centrex lines are a type of central office line with special features. Centrex lines
are standard analog loop start lines, but have different capabilities at the central
office. The only Centrex capability that is relevant for the NexPath Telephony
Server is the ability to transfer a call using hook-flash signalling, so that the NexPath Telephony Server can drop out of the call. Centrex lines are sometimes
known by different names in other parts of the US.

CPC

Calling party control, also known as line supervision or wink disconnect signalling. All of these terms refer to the brief interruption in the battery current on an
analog line, to indicate to connected equipment when a distant party has disconnected. The CPC signal is required by the NexPath Telephony Server on
inbound CO lines, to prevent calls that are in the auto-attendant or conferenced
with other CO lines, from becoming connected indefinitely even though the outside party has hung up. Most if not all central offices in the US provide this signal, but some channel banks (analog line conversion from T1 digital lines) do
not. NexPath does not recommend connecting the NexPath Telephony Server to
channel bank or ISDN-to-analog equipment that does not provide the CPC signal.

CPC Delay

The CPC delay is the time from when the caller actually has disconnected, to
when the central office sends the CPC signal. The NexPath Telephony Server
has a programmable CPC delay compensation adjustment, to compensate for this
time delay, to eliminate long periods of silence at the end of voice mail messages.
This can be programmed by the system administrator. See the System Administration Guide for details. The CPC delay compensation is merely a fixed amount
of time that is chopped off of the end of all voice mail messages. If you find
voice mail messages cut off at the end, the CPC delay compensation factor may
have been set too large. Contact your system administrator.

Day mode

Each extension can be assigned to ring at a different phone or group of phones
depending on whether the system is in the Day mode or Night Mode. Usually,
systems are configured so that calls placed to the operator ring at the operator’s
phone when the system is in Day mode, but ring over the overhead PA speaker
when the system is in Night Mode. Individual extensions may be similarly configured. Day and night mode can be changed from the telephone keypad and
from the web application TelOper, as described in the Users Manual.

Do Not Disturb mode

Individual extensions can be placed in either an “Accept Calls” mode or a “Do
Not Disturb” mode. When an extension is in “Do Not Disturb” mode, calls
placed to it will not ring the phone but instead will be sent directly to voice mail.
If the extension is part of a call distribution group, incoming calls will be routed
past any extensions which are in the “Do Not Disturb” mode and will go on to
the next extension in the group.

extension number

The number an outside caller dials to get to a specific person or department.
Extension numbers are also used to access outside lines, ring groups, PA speakers, voice mail boxes, speed dial numbers, park orbits, and automated attendants.
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FSK

Frequency Shift Keying, in this manual referring to the signalling technique for
control the voice mail light on compatible telephones, and the signalling technique for communicating the caller ID of an inbound call.

hook-flash

The hook-flash is used to communicate to the system that some sort of control
sequence will follow. It is accomplished by depressing the telephone hook switch
for an interval of greater than 50 milliseconds and less than 750 milliseconds (a
millisecond is 1/1000ths of a second, so 750 milliseconds is 3/4 of a second).
Some telephones have a flash button that accomplishes this task.
Note that your telephone system distinguishes between a hang-up, which is
longer than about three-quarters of a second, and a hook-flash, which is a short
depression of the hook switch.
The symbol Flash is used in this manual to indicate a hook-flash.
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inside lines

The physical lines which you will run within your building and connect your
telephones, FAX machines, etc. Also called station lines or inside extension
lines. Designated by the NexPath Telephony Server as IL-1, IL-2, etc.

inside dial tone

A dial tone provided by the NexPath Telephony Server rather than by the local
telephone company. Note that, depending on the dial tone provided by your
phone company, the tone of an inside dial tone and an outside dial tone may be
indistinguishable from one another.

listen in

Listening into an existing conversation or listening to a line after a caller has
already started leaving voice mail (screening voice mail).

Night mode

Each extension can be assigned to ring at a specific phone or group of phones
depending on whether the system is in the Day mode or Night Mode. Usually,
systems are configured so that calls placed to the operator ring at the operator’s
phone when the system is in Day mode, but ring over the overhead PA speaker
when the system is in Night Mode. Individual extensions may be similarly configured. Day and night mode can be changed from the telephone keypad and
from the web application TelOper, as described in the Users Manual.

outside dial tone

A dial tone the local telephone company. Note that, depending on the dial tone
provided by your phone company, the tone of an inside dial tone and an outside
dial tone may be indistinguishable from one another.

outside lines

Sometimes called CO, for Central Office, lines, trunk lines, or telco lines. All
of these terms are synonymous, and refer to the physical lines which come into
your building from the phone company.

park orbit

A special way of putting a call on hold which allows anyone to pick the call up
by dialing the number of the park orbit (a type of public hold).

password protection

To insure that unauthorized people do not retrieve your voice mail, barge into
your conversations, etc., many of the advanced features of the NexPath Telephony Server require that you enter a numerical password to identify yourself to
the system before the feature can be accessed.

physical lines

The actual telephone lines connected to the NexPath Telephony Server.

pickup groups

See ring groups below.

ring groups

Groups of physical telephone lines can be assigned to a ring group, also called a
pickup group. This function is normally used so that a ringing phone can be
picked up from another (non-ringing) phone using the pick up group sequence

* 0 , followed by a single digit ring group number.
An extension can also be assigned to a ring group, so that when the extension is
dialed, the group of phones will ring. The first extension picked up in the group
of ringing phones will get the call.
Note that ring groups are not the same as call distribution groups. See call distribution group above for the definition of a call distribution group.
Short Name

This is the name that is recorded in a voice mai box, so that when a voice mail
message is copied to another mail box, this name recording is prepended to the
message to identify who it is from. Also, the short name is used to identify all
extensions that forward to the voice mail box where it is recorded, to identify the
extensions in the dial by name auto-attendant.

system administrator

This is the person in charge of administering the system, that is, adding or
removing users, assigning users extension numbers and passwords, and changing
other system parameters as needed. Please refer to the NexPath Telephony Server
System Administration Guide for more details on what the system administrator
can and cannot do.

user

In this manual, the term “user” is used to describe someone who has been
assigned an account on the system by the system administrator (i.e., someone
who has been assigned a password, an extension number, a voice mailbox, etc.).
A particular user is identified by the system via his secret password.

VMWI

Visual Mail Waiting Indicator, the light on compatible telephones that indicates
if there is unread voice mail. The VMWI standard for voice mail lights is also
called the FSK technique (see the FSK definition in this glossary), and refers to a
signalling technique for controlling the voice mail light with low speed modemlike tones. Telephones that are caller ID compatible, that have a voice mail indicator, are almost universally VMWI compatible, since both signalling techniques
are in the same Bellcore standard.
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defined 124
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enabling from a telephone 16
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defined 124
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from the web interface (TelOper) 102
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Server 125
clearing a command sequence when using a
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from NexDial 67
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Control page, typical (TelOper) 92
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D
Day mode
defined 125
enabling from a telephone 20
enabling from the web interface (TelOper) 102
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from NexDial 77
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deleting a voice mail message
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E
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defined 125

F
forward calls
enabling from a telephone 13
enabling from NexDial 68
enabling from the desktop web interface
(TelOper) 108
forwarding a voice mail message
to another mail box using NexDial 73
to another mail box using the telephone
keypad 51
to another mail box using the web
interface 100
FSK
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G
greeting
recording using a telephone 52
recording using NexDial 73
recording using the web interface 100
setting the standard or alternate greeting from
NexDial 74
setting your standard or alternate greeting from
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H
help
announcing the command sequences over a
telephone 24
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when in voice mail 52
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performing hold operations from NexDial 66
performing hold operations from
NexDirector 86
performing hold operations from the web
interface (TelOper) 93
placing a call on hold from a telephone 25
retrieving a call using a telephone 25
swapping hold
from the web interface 93
on a telephone 26
hook-flash
defined 126
detailed description 6
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I
initiating a conference
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from NexDial 67
from the web interface 95
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inside dial tone
defined 126
inside lines
defined 126
detailed description 28

outside dial tone
defined 126
outside lines
defined 126
detailed description 34

L

P

line numbers, announcing over a telephone 30
listen in
defined 126
performed from a telephone 31
screening voice mail from NexDial 67
logs, viewing the call logs from the desktop web
interface (TelOper) 105

PA system
making announcements through the 35
picking up calls ringing over the 8
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setting up from NexDial 76
setting up from the telephone 54
setting up from the web interface (TelOper) 98
pager
setup numeric pager notification of new voice
mail
from the telephone 54
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from a telephone 40
from NexDial 66
from the web interface (TelOper) 95
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M
mailbox full 54

N
NexDial
Windows desktop call control application 59
NexDirector
call director program (NexDir) 81
Night mode
defined 126
enabling from a telephone 20
enabling from the web interface (TelOper) 102
numeric pager
setting up from the telephone 54
setting up notification of new voice mail from
NexDial 76
setting up notification of new voice mail from
the web interface (TelOper) 98

O
one beep or ring 7
on-off-on dial tone 47
operator
dialing from the voice mail greeting 56
dialing the operator from a telephone 33
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defined 127
placing a call on hold
from a telephone 25
from NexDial 66
from NexDirector 86
from the web interface (TelOper) 92
playing back
your mail box greeting from NexDial 74
your mailbox greeting over a telephone 52
your mailbox greeting using the web
interface 99

R
record a greeting
using a telephone 52
using NexDial 73
using the web interface 100
recording a copy to intro
from NexDial 73
from web interface (TelOper) 100
recording your short name 55
retrieving a call from hold
from a telephone 25
from the web interface (TelOper) 93
using NexDial 66
using NexDirector 86
ring groups
defined 127
detailed description 8
picking up from NexDial 66
picking up using a telephone 40
picking up using the web interface
(TelOper) 95
rings 7

S
screening voice mail
from NexDial 67
from the telephone 31
sending a call to voice mail

from NexDial 68
from the web interface (TelOper) 93
setting up a conference call
from a telephone 19
from NexDial 67
from the web interface (TelOper) 94
setting up transfers
from a telephone 41
from NexDial 67
from the web interface (TelOper) 94
short name
defined 127
speed dial
using buttons in NexDial 66
speed dial buttons
on the desktop web interface (TelOper), adding
and deleting 104
stutter dial tone 47
summary of the keypad sequences used with a
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swapping between a current call and a call on
hold
from a telephone 16, 26
from NexDial 66
from the web interface 93
system administrator, defined 127
system configuration, displaying via the web
interface (TelOper) 101

T
TAPI
Installing the NexPath TAPI TSP 109
NexPath TAPI Interface 109
Uninstalling the NexPath TAPI TSP 115
Using the NexPath TSP with other
programs 113
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defined 126
telephone keypad when in voice mail
(diagram) 49
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three beeps 8
time and date announcement
setting from NexDial 75
setting from web interface (TelOper) 98
transferring calls
from a telephone 41
using the web interface (TelOper) 94
trunk lines
defined 126
two beeps 7

U
URL of phone system 90
user, defined 127

V
viewing the call logs from the desktop web
interface (TelOper) 106
VMWI
defined 127
voice mail
accessing from
NexDial 70
the web interface (TelOper) 93
accessing from an inside line 48
accessing from an outside line 53
alternate greeting 53
announce time and/or date
setting from NexDial 75
setting from the web interface
(TelOper) 98
deleting a message using NexDial 74
deleting a message using the web
interface 100
determining if you have new messages using
your telephone 47
dialing a call back number from NexDial 72
dialing a call back number from the keypad 51
forwarding messages to other mail boxes
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from NexDial 73
from the telephone 51
from the web interface (TelOper) 100
help over telephone 52
main menu 50
message menu 49
message sorting order 51
playing back messages from the telephone 51
playing back your greeting from a
telephone 52
playing back your greeting using NexDial 74
playing back your greeting using the web
interface 99
recording a greeting
from a telephone 52
from NexDial 73
from the web interface 100
recording your short name 55
setting up numeric pager notification
from NexDial 76
from the telephone 54
from the web interface (TelOper) 98
standard greeting 53
use of telephone keypad when in 49
Voice Mail Alert
button changes color in NexDirector 86
pop-up on the web browser interface
(TelOper) 96
red indicator on NexDial program 68
voice mailbox full 54

